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Preface
Welcome to the Hyperion Analyzer Administrator’s Guide. This preface discusses 
the following topics:

● “Purpose” on page ix

● “Audience” on page ix

● “Document Structure” on page x

● “Where to Find Documentation” on page x

● “Conventions” on page xi

● “Additional Support” on page xiii

Purpose
This guide provides you with all the information that you need to administer 
Hyperion Analyzer. It explains the Hyperion Analyzer features and options, and 
contains the concepts, processes, procedures, formats, tasks, and examples that 
you need to use the software.

Audience
This guide is for administrators who are responsible for administering and 
supporting Hyperion Analyzer. 
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Document Structure
This document contains the following information: 

Chapter 1, “Administrating Hyperion Analyzer,” introduces the tasks involved 
with the administration of Hyperion Analyzer.

Chapter 2, “Application Overview,” introduces Hyperion Analyzer and its 
components.

Chapter 3, “Hyperion Analyzer Utilities,” describes the various utilities included 
with Hyperion Analyzer.

Chapter 4, “Managing Security and Access,” describes how to set up and manage 
security.

Chapter 5, “Configuration Options,” describes the configurations available for 
Hyperion Analyzer.

Chapter 6, “HTML Web Client Templates, Tags, and Actions,” describes the 
templates, tags, and actions for the HTML Web Client.

Chapter 7, “IBM WebSphere Application Server,” describes administering 
Hyperion Analyzer on IBM WebSphere.

Glossary contains a list of key terms and their definitions.

Index contains a list of Hyperion Analyzer terms and their page references. 

Where to Find Documentation
All Hyperion Analyzer documentation is accessible from the following locations:

● The HTML Information Map can be accessed by starting any Hyperion 
Analyzer client and selecting Information Map from the Help button or from 
the Help menu command. 

● Online help is accessible from the component that it documents. Start the 
product and click the Help button or menu command.

● The Hyperion Solutions Web site is located at http://www.hyperion.com.

● Access to the Hyperion Download Center is through 
http://hyperion.subscribenet.com .
x ■ Hyperion Analyzer Administrator’s Guide
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➤ To access the documentation from the Hyperion Solutions Web site:

1. Log on to http://www.hyperion.com.

2. Select Support from the menu bar.

3. Enter your username and password, and click Login. 

Tip: If you do not have a username and password, click Register on the login page 
to request them.

4. Select Software/Documentation.

5. From the Product list box, select Hyperion Analyzer.

6. From the Display list box, select Documentation, then click Submit. 

➤ To access documentation from the Hyperion Download Center:

1. Log on to http://hyperion.subscribenet.com .

2. In the Login ID and Password text boxes, type your assigned login ID name 
and password. Then click Login.

3. If you are a member on multiple Download Center accounts, select the account 
that you want to use for the current session.

4. In the Product List, select Hyperion Analyzer.

5. In the New Releases tab, select Hyperion Analyzer Release 6.5.

Conventions
The following table shows the conventions used in this document:

Table i: Conventions Used in This Document 

Item Meaning

Arrows indicate the beginning of a procedure consisting of 
sequential steps or one-step procedures.

Brackets [] In examples, brackets indicate that the enclosed elements 
are optional.

Bold Bold in procedural steps highlights major interface 
elements.
■ xiHyperion Analyzer Administrator’s Guide
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CAPITAL LETTERS Capital letters denote commands and various IDs. 
(Example: CLEARBLOCK command)

Ctrl + 0 Keystroke combinations shown with the plus sign (+) 
indicate that you should press the first key and hold it 
while you press the next key. Do not type the + sign.

Example text Courier font indicates that the material shown is a code or 
syntax example.

Courier italics Courier italic text indicates a variable field in command 
syntax. Substitute a value in place of the variable shown in 
Courier italics.

ARBORPATH When you see the environment variable ARBORPATH in 
italics, substitute the value of ARBORPATH from your site.

Italics Italics in a product-related term in the body of a book 
indicates that the term is also included in the glossary of 
the book.

n, x Italic n stands for a variable number; italic x can stand for 
a variable number or an alphabet. These variables are 
sometimes found in formulas.

Ellipses (...) Ellipsis points indicate that text has been omitted from an 
example.

Mouse orientation This document provides examples and procedures using 
a right-handed mouse. If you use a left-handed mouse, 
adjust the procedures accordingly.

Menu options Options in menus are shown in the following format. 
Substitute the appropriate option names in the 
placeholders, as indicated.

Menu name > Menu command > Extended menu 
command 

For example: 1. Select File > Desktop > Accounts. 

Table i: Conventions Used in This Document (Continued)

Item Meaning
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Additional Support
In addition to providing documentation and online help, Hyperion offers the 
following support for product information.

How to Order Printed Documentation
To order printed documentation: 

● Visit the Hyperion Solutions Web site at http://www.hyperion.com .

● In the United States, call Hyperion Solutions Customer Support at 
877-901-4975.

● From outside the United States, including Canada, call Hyperion Solutions 
Customer Support at 203-703-3600. Clients who are not serviced by support 
from North America should call their local support centers.

Education Services
Hyperion offers a variety of training options, including instructor-led training, 
custom training, and eTraining. This education covers all Hyperion applications 
and technologies and is geared to administrators, end users, and information 
systems (IS) professionals.

Instructor-led training is delivered in formats and in locations suited to Hyperion’s 
diverse, global customers. Hyperion Authorized Training Centers are certified to 
deliver courses developed by Hyperion. Custom Education Services—training on 
the configured and tailored applications that employees use on the job—is another 
option to enhance user productivity and to ensure smooth day-to-day operations. 
A service called eTraining—including computer-based training, Web-based 
training, and interactive Virtual Classroom training—provides a cost-effective 
means of giving users a hands-on introduction to product features and functions. 
Computer-based training (CBT) and Web-based training (WBT) provide 
high-quality, self-paced training at the user’s convenience, regardless of location.

For more information about training, contact your Regional Education Manager 
or visit the Hyperion Solutions Web site at http://www.hyperion.com to see 
a list of all training classes. 
■ xiiiHyperion Analyzer Administrator’s Guide
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Consulting Services
Hyperion Consulting Services assists customers in maximizing the use of, and the 
return on investment in, Hyperion products. Experienced Hyperion consultants 
and Hyperion Alliance Partners assist organizations in tailoring solutions to their 
particular requirements, such as reporting, analysis, modeling, and planning. 
Specific services include implementation consulting, custom business solutions, 
data integration, and technical consulting. Additionally, Hyperion offers a variety 
of Services Packages and Reviews.

For more information about Consulting Services, Services Packages and 
Reviews, as well as the services offered by Alliance Partners, contact your local 
consulting services representative, or visit the Hyperion Solutions Web site at 
http://www.hyperion.com to see a list of all Hyperion Alliance Partners.

Technical Support
Hyperion provides Web-based and telephone support to ensure that clients resolve 
product issues quickly and accurately. This support is available for all Hyperion 
products at no additional cost to clients with a current maintenance agreement.

● For Web-based support, or to see complete information on 
available support options, visit the Hyperion Solutions Web site 
at http://www.hyperion.com.

● In the United States, call 877-901-4975 for Hyperion Solutions Customer 
Support.

● From outside the United States, including Canada, call Hyperion Solutions 
Customer Support at 203-703-3600. Clients who are not serviced by support 
from North America should call their local support centers. 

Documentation Feedback
Hyperion strives to provide complete and accurate documentation. We value 
your opinions on this documentation and want to hear from you. Send us your 
comments by completing the survey available at http://www.hyperion.com.
xiv ■ Hyperion Analyzer Administrator’s Guide
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Chapter
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Hyperion Analyzer Adm
Administrating Hyperion Analyzer
Hyperion Analyzer administration consists of the following tasks:

Installation and Redeployment

The Hyperion Analyzer Installation Guide describes installation and installation 
options essential to installing and configuring Hyperion Analyzer. This guide 
includes procedures for establishing a Hyperion Analyzer repository, executing 
silent installations, and installing Hyperion Analyzer samples. Redeployment 
follows the same process as installation, and administrators reconfiguring or 
redeploying Hyperion Analyzer are also encouraged to consult the Hyperion 
Analyzer Installation Guide.

Managing Security and Access

Administrators may choose to use the default Hyperion Analyzer authentication 
and security, Hyperion Essbase authentication and external authentication 
methods to validate users and logons. All security and authentication protocols are 
managed via Hyperion Analyzer Administration Tools. For more information, see 
Chapter 4, “Managing Security and Access”. 

Managing Users, User Groups, Database Connections

Hyperion Analyzer Administration Tools is the primary interface for managing 
users, user groups and database connections. In addition, administrators can assign 
pre-defined roles that control user access to the Hyperion Analyzer system.
■ 15inistrator’s Guide
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Optimizing the Hyperion Analyzer System

System Administrators can use the Java-based Hyperion Analyzer Analysis Server 
Console to monitor, maintain and optimize the Hyperion Analyzer System. This 
console provides statistics on server logons, data hits, and data response times. 
Administrators can also manually disconnect users idle in excess of a time 
limitation, and show, clear and export console output.

Education and Training

Hyperion Analyzer provides Administrators with tools to support user training and 
education. Significant among these tools are:

● The Hyperion Analyzer Sample Report Group

● Hyperion Analyzer API Toolkit Samples

● Documentation deliverables in HTML and PDF.

Hyperion Analyzer Resources

Hyperion Analyzer Administration Tools
The Hyperion Analyzer Administration Tools client provides a 100% Java 
graphical interface for managing users, users groups and database connections via 
a supported Web browser. It is also instrumental in setting authentication services 
for the Hyperion Analyzer system.

Hyperion Analyzer Analysis Server Console

System Administrators can use the Java-based Hyperion Analyzer Analysis Server 
Console to monitor, maintain and optimize the Hyperion Analyzer System. This 
console provides statistics on server logons, data hits, and data response times. 
Administrators can also manually disconnect users idle in excess of a time 
limitation, and show, clear and export console output.

Hyperion Analyzer Setup.cmd Installation Wizard

A Setup.cmd installation wizard is delivered with Hyperion Analyzer that enables 
Evaluation, Typical and Custom installations of Hyperion Analyzer on Windows 
NT, and Sun Solaris operating systems.
16 ■ Hyperion Analyzer Administrator’s Guide
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Hyperion Analyzer Batch Import/Export Utility

The new batch import/export utility enables administrators to import reports, 
report groups, user IDs, point of view definitions and personal variable definitions. 
See Chapter 3, “Hyperion Analyzer Utilities”, for more information.

The batch import/export utility is also instrumental in migrating from certain 
releases of Hyperion Analyzer to the current release.

Hyperion Analyzer Save As Web Page Batch Utility

The new Hyperion Analyzer Save As Web Page Batch Utility automates the 
process of publishing Hyperion Analyzer reports to the Web, using JSP templates. 
See Chapter 3, “Hyperion Analyzer Utilities”, for more information.
■ 17Hyperion Analyzer Administrator’s Guide
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Application Overview
Hyperion Analyzer consists of the following components:

● Four client applications

● An analysis server

● A repository

● An API Toolkit

The repository centrally stores Hyperion Analyzer system data, user IDs, user 
preferences, and report definitions in relational database tables.

The Hyperion Analyzer Analysis Server communicates report definitions and 
system information between the repository, Web clients, and Hyperion Analyzer 
Administration Tools.

The Hyperion Analyzer Administration Tools client provides a 100-percent 
Java graphical interface for managing users, users groups, and database 
connections using a supported Web browser. It also provides access to several 
administration utilities.

The Hyperion Analyzer Java Web Client is an easy-to-use graphical interface 
that enables online analysis of both Hyperion Essbase and relational data. You can 
design and format custom analysis applications without “coding.” 

The Hyperion Analyzer Windows Client is the same easy-to-use Java Web 
Client interface and functionality delivered as a standalone Java application for 
supported Microsoft Windows operating systems.

The Hyperion Analyzer HTML Web Client is a 100-percent HTML thin client 
used by way of a supported Web browser. It is engineered for information 
consumers who do not require advanced design and content-creation capabilities.
■ 19inistrator’s Guide
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The Hyperion Analyzer API Toolkit enables developers to incorporate the 
Hyperion Analyzer Java Web Client look and feel and functionality into their own 
custom Web applications.

Hyperion Analyzer Architecture

The following illustration represents the architecture of Hyperion Analyzer and 
illustrates how the different components work together.

Figure 1: Hyperion Analyzer Architecture Diagram
20 ■ Hyperion Analyzer Administrator’s Guide
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Repository Tables
The repository centrally stores Hyperion Analyzer system data, user IDs, user 
preferences and report definitions in relational database tables.

The repository is multi-user and is typically installed in shared local area network 
locations rather than on individual user desktops. This kind of installation enables 
users to log on to any machine on the network or Intranet. Users can also access 
their own reports and user preferences without copying files or performing 
import/export tasks.

For security and system integrity, repository tables cannot be edited or 
manipulated.

Table 1: Repository Tables 

Table Function

TBLAUTHSRVR Records the server address of the 
authenticating server.

TBLAUTHTYPE Records the authentication server 
type definition.

TBLDATABASES Records the database connections 
available to client applications.

TBLDBTYPE Records the data source definitions 
for TBLDATABASES records.

TBLEXTERNALGROUPS Records the mapping between 
external authentication directory 
server groups and Hyperion 
Analyzer user groups.

TBLGLOBALDB Records global connection definition 
for TBLDATABSES records.

TBLOBJECTS Records the types of objects in the 
repository: Database, Report, Report 
Group, User, or User Group, etc.

TBLOBJINSTANCEPERMISSIONS Records the object instance 
permissions definition.

TBLOBJLINKSOPS Records additional properties of 
TBLOBJLINKS records.
■ 21Hyperion Analyzer Administrator’s Guide
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Applet Parameters
There are two kinds of applet parameters:

TBLOBJLINKS Records data required to maintain 
links between objects.

TBLOBJTYPEPERMISSIONS Records object type permission 
definitions.

TBLOBJTYPES Records the object type IDs for the 
TBLOBJ table.

TBLPARENTCHILD Records report-report group 
relationship data.

TBLPERMSINROLESMAP Records the relationship between 
objects and roles.

TBLREPORTGROUPS Records report group definitions.

TBLREPORTS Records report definitions.

TBLREPORTSTATE Records the report content definition 
and global formatting data.

TBLREPORTTYPE Records report type definitions.

TBLROLES Records role definitions.

TBLSYSTEMPROPS Records system level java properties 
affecting all users.

TBLUSERANDGROUPHASROLEMAP Records user and user group – role 
relationship data.

TBLUSERCREDENTIALS Records the token created during any 
form of authentication.

TBLUSERGROUPS Records user group definitions.

TBLUSERS Records user ID definitions.

TBLUSERSINUSERGROUPMAP Records user-user group 
relationships.

Table Function
22 ■ Hyperion Analyzer Administrator’s Guide
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● Applet modifiers define the applet to the browser. The World Wide Web 
Consortium codifies applet modifiers.

● Applet parameters pass values to the applet. Applet parameters are 
applet-specific.

Table 2: Applet Modifiers

Applet Modifiers Modifier Description

WIDTH Amount of horizontal space used by Applet. The 
WIDTH modifier allows expression in terms of a 
percentage.

HEIGHT Amount of vertical space used by Applet. The HEIGHT 
modifier allows expression in terms of a percentage.

CODE The Applet’s main class name. Changing this value 
prevents the correct classes from being loaded.

CODEBASE The URL of the Applet’s main class.

NAME The name of this instance of the Applet. The NAME 
modifier enables multiple Applets on the same page to 
locate each other and communicate.

ARCHIVE The URL of the .JAR archive containing the classes. 
Netscape browsers download the archive and use the 
classes therein to accelerate startup. Should not be 
changed when specified in the Applet.html. Locally 
installed classes should omit this modifier.

Table 3: Applet Parameters 

Applet Parameter Description

BGColor Sets an RGB color for the Applet background. The 
default is light gray.

Debug When set to TRUE, the Debug Boolean string value 
(TRUE/FALSE) enables objects to report debugging 
information to the Java-based Hyperion Analyzer 
Analysis Server console. The default value is FALSE.

FrameHeight The FrameHeight string value is the height in pixels of 
the Hyperion Analyzer frame.
■ 23Hyperion Analyzer Administrator’s Guide
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FrameWidth The FrameWidth string value is the width in pixels of 
the Hyperion Analyzer frame.

HideConfirmDialog When set to TRUE, the HideConfirmDialog string 
value hides confirmation dialog boxes. This is TRUE 
only for events triggered using scripting. Confirmation 
dialog boxes triggered by conventional GUI object 
events display normally. The default value is FALSE.

HideErrorDialog When set to TRUE, the HideErrorDialog string value 
hides error dialog boxes. This is only TRUE for events 
triggered using scripting. Error dialog boxes triggered 
by conventional GUI object events display normally. 
The default value is FALSE.

Password The string value of a valid password. Automatic login is 
triggered when all pre-requisite parameters are 
provided.

ServerURL The ServerURL string value is the targeted Hyperion 
Analyzer Analysis Server name or IP address. When no 
value is set, Hyperion Analyzer attempts to locate a 
Hyperion Analyzer Analysis Server console. The 
default value is FALSE.

UseFrame  When set to TRUE, the UseFrame string value displays 
the applet in an independent window instead of in the 
Web browser interface. The default value is FALSE.

UserID The string value of a valid user ID. Automatic login is 
triggered when all pre-requisite parameters are 
provided.

SupportResolveMember When set to TRUE, the Hyperion Analyzer Java Web 
Client validates member parameters against the 
Hyperion Essbase outline, before executing the API 
method. When set to FALSE the Hyperion Analyzer 
Java Web Client validates only member IDs, but does 
not validate aliases verbatim (for the purpose of 
expediting processing). The default value is TRUE.

Table 3: Applet Parameters (Continued)

Applet Parameter Description
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Managing Memory Allocation
Hyperion Analyzer relies upon the Java Virtual Machine (JVM) to manage 
memory allocation in conjunction with the operating system.

As the number of instantiated application objects grows and diminishes, the Java 
Virtual Machine requests that the operating system allocate and free memory 
proportionally.

The JVM monitors increasing and decreasing memory allocation, in order to 
determine the memory required to satisfy application needs and simultaneously 
minimize JVM requests to the operating system.

The JVM may therefore not immediately release allocated memory, in an effort to 
maintain the amount typically required by the Hyperion Analyzer application.

Support Undo  When set to TRUE, the SupportUndo string value 
enables undo and redo capability for applicable API 
events. Developers are cautioned; this parameter slows 
application processing. The default value is FALSE.

language_COUNTRY Sets locale parameters, using ISO-639 two-letter codes 
for language (in lower case) and country (in upper case) 
(for example, enUS for English, United States). The 
default is determined by the client machine's 
configuration.

Table 3: Applet Parameters (Continued)

Applet Parameter Description
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Hyperion Analyzer 5.0.3 Migration Utility
Because Hyperion Analyzer has been completely re-architected, it is necessary for 
Hyperion Analyzer 5.0.3 users to migrate reports, report groups and system 
information to the current Hyperion Analyzer release.

Because the re-architecture of Hyperion Analyzer is a paradigm shift in 
technology, quality, scalability, and usability, the migration process is in fact a 
conversion of release 5.0.3 database tables to a new release 6.5 database table 
design.

The migration process is, therefore, not a one-to-one migration of 5.0.3 data into 
6.5 data. It is instead an attempt to port as much 5.0.3 data to the new 6.5 format 
as is possible. Items that cannot be converted automatically are recorded and 
reported in a conversion log.

Users can review conversion logs in the course of migration, or scroll to the bottom 
of text editors displaying .ARD and .ARG output files.

Two Kinds of Conversion
Two separate conversion utilities are provided to migrate different database table 
sets:

● The AdminMigrate.exe conversion utility is a release 5.0.3 Administration 
Tools client with a migration menu bar. It is used to migrate Hyperion 
Analyzer 5.0.3 administrative database tables to the release 6.5 table design.
■ 27inistrator’s Guide
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● The AnalyzerMigrate.exe conversion utility is a release 5.0.3 Windows client 
with a migration menu bar. It is used to migrate Hyperion Analyzer 5.0.3 
database tables to the release 6.5 table design.

Note: Important! Hyperion Analyzer recommends migrating administrative database 
tables before migrating Analyzer database tables.

 Overview of the Migration Process
The migration process consists of the following steps:

● Maintain installations of Hyperion Analyzer 5.0.3 and 6.5 releases.

● Save the conversion utilities, AdminMigrate.exe and AnalyzerMigrate.exe 
to the Applications subdirectory of the Hyperion Analyzer 5.0.3 directory.

● Double-click to start the AdminMigrate.exe conversion utility.

● Convert the following items to their corresponding export file.

● Import the export file to the release 6.5 repository.

● Repeat the process with the AnalyzerMigrate.exe conversion utility.

Although Report Groups are imported directly into the repository, reports are not 
saved to the repository until users execute the Save command. Reports and report 
groups are not shared to other users until report group properties are set to share 
Analyzer content with selected user groups.

The Import command amends existing 6.5 database repository. It does not 
overwrite the repository.

Table i: Conversion Utility Process

Conversion Utility Command Converts To... Suffix

AdminMigrate.exe Migrate a User User ID export file .ARU

Migrate all Users User ID export file .ARU

AnalyzerMigrate.exe Migrate a View Report export file .ARD

Migrate a View 
Group

Report Group 
export file

.ARG
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Converting Release 5.0.3 Users to Release 6.5 Users
Before you can migrate Hyperion Analyzer administrative data you must save the 
AdminMigrate.exe file to the Applications subdirectory of the Hyperion Analyzer 
5.0.3 directory. Users also must have access to their Hyperion Analyzer 5.0.3 
repository.

➤ To start the AdminMigrate.exe conversion utility:

1. Open Windows Explorer.

2. Double-click the AdminMigrate.exe file name (in the Applications 
subdirectory of the Hyperion Analyzer 5.0.3 directory).

The Hyperion Analyzer 5.0.3 Administration Tools toolbar displays.

3. Click the Manage toolbar button.

The Management window displays.

➤ To convert Hyperion Analyzer 5.0.3 user(s) to a Hyperion Analyzer 6.5 user(s) 
export file (.ARU):

1. Click the Migrate menu bar command, and select one of the following options 
from the sub-menu:

● Migrate All Users - Select Migrate All Users… to convert all user IDs in 
the repository. After selecting this option, then proceed to step 4.

● Migrate A User - Select Migrate A Users… to convert specific users. After 
selecting this option, proceed to the next step.

The Users dialog box displays.

2. Select a user ID from the drop down list box.

3. Click OK.

The Save As dialog box displays. This dialog box will save the converted 
user(s) to an .ARU export file.

4. Navigate to a location in which you would like to save the .ARU export file.

5. Enter a name for the .ARU export file.

6. Click the Save As dialog box OK button.
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Conversion log messages, if any, will display in the Migration Errors dialog 
box. You can review these messages now, or refer to them later, by reviewing 
the .ARU file in a text editor. Click OK to dismiss the Migration Errors dialog 
box.

➤ To import a Hyperion Analyzer 6.5 user(s) export file (.ARU):

1. Start Hyperion Analyzer 6.5 Administration Tools

2. From the Menu Bar select File | Import.

The Open dialog box displays.

3. Enter the location and filename of the exported .ARU file.

4. Click OK.

The users are saved to the repository.

Converting a View to a Report

Note: Before you can migrate Hyperion Analyzer data you must save the 
AnalyzerMigrate.exe file to the Applications subdirectory of the Hyperion Analyzer 5.0.3 
directory. Users also must have access to their Hyperion Analyzer 5.0.3 repository.

➤ To start the AnalyzerMigrate.exe conversion utility:

1. Open Windows Explorer.

2. Double-click the AnalyzerMigrate.exe file name (in the Applications 
subdirectory of the Hyperion Analyzer 5.0.3 directory).

3. A Hyperion Analyzer 5.0.3 Windows client with a special Migration menu bar 
displays.

➤ To convert a Hyperion Analyzer 5.0.3 view to a Hyperion Analyzer 6.5 export file 
(.ARD):

1. Click the Migrate menu bar command, and select Migrate a View from the 
sub-menu.

The Hyperion Analyzer 5.0.3 View Manager displays.

2. Click to select the view group tab of the view you wish to convert.

3. Click to select the view name of the view you wish to convert.

4. Click the View Manager OK button.
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The Save As dialog box displays. This dialog box will save the converted view 
to an .ARD export file.

5. Navigate to a location in which you would like to save the .ARD export file.

6. Enter a name for the .ARD export file.

7. Click the Save As dialog box OK button.

Conversion log messages, if any, will display in the Migration Errors dialog 
box. You can review these messages now, or refer to them later, by reviewing 
the .ARD file in a text editor. Click OK to dismiss the Migration Errors dialog 
box.

The Information dialog box displays when conversion is complete. Its 
message states:

“Finished migrating view <<view name>> into <<pathname>> 
<<filename.ard>>.”

8. Click OK.

➤ To import a Hyperion Analyzer 6.5 export file (.ARD):

1. Start the Hyperion Analyzer 6.5 Java Web Client.

2. From the Menu Bar select File | Import | Report.

The Open dialog box displays.

3. Enter the location and filename of the exported .ARD file.

4. Click OK.

The Map Connection dialog box displays.

5. Select a database connection from the Exported Connection list, and then 
select its equivalent database connection in the Available Database 
Connections list.

6. Click the Map It! button.

The mapped database connection is displayed in the Mapped Connections list. 
Repeat steps 5 and 6 until all database connections in the report have been 
mapped to an equivalent database connection.

7. When all database connections have been mapped, click OK.
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Converting View Groups to Report Groups

Note: Before you can migrate Hyperion Analyzer data you must save the 
AnalyzerMigrate.exe file to the Applications subdirectory of the Hyperion Analyzer 5.0.3 
directory. Users also must have access to their Hyperion Analyzer 5.0.3 repository.

➤ To start the AnalyzerMigrate.exe conversion utility:

1. Open Windows Explorer.

2. Double-click the AnalyzerMigrate.exe file name (in the Applications 
subdirectory of the Hyperion Analyzer 5.0.3 directory).

3. A Hyperion Analyzer 5.0.3 Windows client with a special Migration menu bar 
displays.

➤ To convert a Hyperion Analyzer 5.0.3 view group to a Hyperion Analyzer 6.5 
report group export file (.ARG):

1. Click the Migrate menu bar command, and select Migrate a Group from the 
sub-menu.

The Select Hyperion Analyzer Desktop Group dialog box displays.

2. Select a view group from the drop down list box.

3. Click OK.

The Save As dialog box displays. This dialog box will save the converted view 
group to an .ARG export file.

4. Navigate to a location in which you would like to save the .ARG export file.

5. Enter a name for the .ARG export file.

6. Click the Save As dialog box OK button.

Conversion log messages, if any, will display in the Migration Errors dialog 
box. You can review these messages now, or refer to them later, by reviewing 
the .ARG file in a text editor. Click OK to dismiss the Migration Errors dialog 
box.

The Information dialog box displays when conversion is complete. Its 
message states:

“Finished migrating view group <<view group name>> into 
<<pathname>> <<filename.arg>>.”

7. Click OK.
32 ■ Hyperion Analyzer Administrator’s Guide



Hyperion Analyzer Utilities

3

➤ To import a Hyperion Analyzer 6.5 report group export file (.ARG):

1. Start the Hyperion Analyzer 6.5 Java Web Client.

2. From the Menu Bar select File | Import | Report Group.

The Open dialog box displays.

3. Enter the location and filename of the exported .ARG file.

4. Click OK.

The Map Connection dialog box displays.

5. Select a database connection from the Exported Connection list, and then 
select its equivalent database connection in the Available Database 
Connections list.

6. Click the Map It! button.

The mapped database connection is displayed in the Mapped Connections list. 
Repeat steps 5 and 6 until all database connections in the report have been 
mapped to an equivalent database connection.

7. When all database connections have been mapped, click OK.

The Specify Report Group Name dialog box displays.

8. Enter a name for the release 6.5 report group, and click OK.

The report group is saved to the repository.

Conversion Exceptions
Because the migration process is not a one-to-one migration of 5.0.3 data into 6.5 
database tables, some 5.0.3 data cannot be converted. Items that cannot be 
converted automatically are recorded and reported in a conversion log.

Users can review conversion logs in the course of migration, or scroll to the bottom 
of text editors displaying .ARD and .ARG output files.

Due to the diverse use of Hyperion Analyzer, every foreseeable exception cannot 
be addressed, but a summary of common conversion exceptions follows:
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{system} and defaultuser Do Not Migrate
The Release 5.0.3 user ID {system} was used to share content with all users in the 
Hyperion Analyzer system. Due to security considerations, there is no equivalency 
in Hyperion Analyzer 6.5. Users and administrators must now explicitly share 
report groups with user group members.

Owning and Sharing
Owning and Sharing properties do not migrate. Hyperion Analyzer 6.5 reports and 
report groups are not shared to other users until report group properties are set to 
share Hyperion Analyzer content with selected user groups.

Linked Views Must Be Converted Together in a View 
Group
Views that are linked must be placed in the same view group and migrated 
together. Linked reports that are migrated individually, are converted without 
links.

Unique Member and Calculation Names
Users that name calculation definitions the same name as dimension members, 
may encounter conversion errors. Give calculation definitions unique names.

No Defaults for Custom Report Selection Controls
Hyperion Analyzer 5 Custom Report selection controls (radio button group, tab 
set, list box, and slider bar) do not convert with default settings. This means that 
when custom reports are displayed, the selection control member selections are not 
applied to the corresponding data objects, until focus is given to the specific 
control. When conversion is complete, the report can be saved with new default 
settings.

Named Report Startup Options
Named Report Startup Options (User Preferences) do not migrate. In order to 
access to reports of this sort after migration, the report must be assigned to a user 
group using the Administration Tools client.
34 ■ Hyperion Analyzer Administrator’s Guide



Hyperion Analyzer Utilities

3

Common Conversion Exceptions

 

Reports:

Unable to find axis.

Unable to find dimension.

Unable to find member.

Unable to migrate view.

Unable to export database information.

Unable to migrate Hyperion Essbase ParentFirst setting.

Unable to migrate image.

Unable to load pinboard.

Unable to migrate calculation.

Unable to migrate Sort first X members.

Unable to migrate data formatting for technical reasons (HYADTOFormatFont has 
serialization).

Unable to migrate Show/Hides on ranges of values.

Unable to find axis for Show/Hide.

Unable to migrate drill link to executable.

Unable to migrate relational or MS views.

Custom Reports:

Unable to migrate label alignment.

Unable to migrate panel border width.

Unable to migrate panel caption.

Unable to migrate panel font.

Unable to migrate radio group caption.

Unable to migrate radio group hint.

Unable to migrate radio group color.
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Hyperion Analyzer Import/Export Utility
Users with privileges can create and delete user IDs and user group profiles by 
importing a valid .aru XML file. Import functionality is also integral to migrating 
Hyperion Analyzer 5.0.3 users to Release 6.5.

Import Process Order
The XML file is processed in the following order:

1. Delete Users

2. Delete User Groups

3. Create User Groups

4. Create Users

5. Delete Personal Variable definitions

6. Create Personal Variable definitions

7. Delete POV definitions

8. Create POV definitions

Unable to migrate radio group font.

Unable to migrate service tab order.

Unable to migrate service tab stop.

Unable to migrate service hint.

Unable to migrate tab set hint.

Unable to migrate tab set font.

Unable to migrate combo box hint.

Unable to migrate combo box font.

Unable to migrate form due to incomplete loading.

Unable to find component.

Custom Reports:
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Importing an .ARU XML file
The .aru xml file can be imported from the Hyperion Analyzer Administration 
Tools File | Import menu, or from the command line.

➤ To import and execute an XML file using Administration Tools:

1. Select File | Import from the Administration Tools Menu bar.

The Open dialog box is displayed.

2. Navigate to and select the .aru file.

3. Click OK.

The file is imported and processed.

➤ To import and execute an XML file using the command line, enter the following 
text at the command line of the Hyperion Analyzer drive:

Admin.bat [filename.aru] [user_ID] [Password]

XML File Format Example
A sample XML import file and a line-by-line explanation follow:

1)  <?xml version="1.0" encoding="UTF-8"?>

2)  <AnalyzerAdmin>

3)  <CreateUserGroups>

4)  <DefaultRole Name="Interactive User"/>

5)  <DefaultRole Name="Information Consumer"/>

6)  <UserGroup Name="GroupA" Description="Some Description"/>

7)  <UserGroup Name="GroupB" Description="Another Description">

8)  <Role Name="Power User"/>

9)  </UserGroup>

10)  <UserGroup Name="GroupC"/>

11)  </CreateUserGroups>

12)  <CreateUsers Password="Pwd" ChangePwd="true" 
TemplateProperties="User50">

13)  <DefaultUserGroup Name="GroupA"/>

14)  <DefaultRole Name="Power User"/>
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15)  <User LoginID="User1" Name="TestName"/>

16)  <User LoginID="User2" Password="Pwds" ChangePwd="false"/>

17)  <User LoginID="User3" TemplateProperties="User27">

18)  <UserGroup Name="Administrators"/>

19)  <Role Name="Power User"/>

20)  </User>

21)  </CreateUsers>

22)  <DeleteUsers>

23)  <User LoginID="OldUser1"/>

24)  <User LoginID="OldUser2"/>

25)  </DeleteUsers>

26)  <DeleteUserGroups>

27)  <UserGroup Name="OldGroup1"/>

28)  <UserGroup Name="OldGroup2"/>

29)  </DeleteUserGroups>

30)  <ModifyUsers>

31)  <User LoginID="Administrator">

32)  <AddPersonalVariable Name="MarketPV" Database=
"localhost:Sample:Basic" Dimension="Market">

33)  <Member Name="Market" SelectionMode="CHILDREN"/>

34)  <Member Name="East" SelectionMode="CHILDREN"/>

35)  </AddPersonalVariable>

36)  <AddPersonalVariable Name="YearPV" Database=
"localhost:Sample:Basic" Dimension="Year">

37)  <Member Name="Qtr4" SelectionMode="PREVIOUS" PreviousCount=
"2"/>

38)  </AddPersonalVariable>

39)  <AddPointOfView Name="BatchPOV" Database=
"localhost:Sample:Basic" Active="True">

40)  <AxisSelections Axis="Columns">

41)  <Dimension Name="Market">

42)  <Member Name="East"/>

43)  <Member Name="West" SelectionMode="CHILDREN"/>
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44)  </Dimension>

45)  <Dimension Name="Product">

46)  <Member Name="Product" SelectionMode="CHILDREN"/>

47)  </Dimension>

48)  </AxisSelections>

49)  <AxisSelections Axis="Rows">

50)  <Dimension Name="Year">

51)  <Member Name="Year" SelectionMode="CHILDREN"/>

52)  </Dimension>

53)  </AxisSelections>

54)  <AxisSelections Axis="Pages">

55)  <Dimension Name="Scenario">

56)  <Member Name="Scenario" SelectionMode="CHILDREN"/>

57)  </Dimension>

58)  </AxisSelections>

59)  </AddPointOfView>

60)  <RemovePersonalVariable Name="YearPV" Database=
"localhost:Sample:Basic"/>

61)  <RemovePointOfView Name="AnotherPOV" Database=
"localhost:Sample:Basic"/>

62)  </User>

63)  <User LoginID="TestUser">

64)  <RemovePointOfView Name="TestPOV" Database=
"localhost:Demo:Basic"/>

65)  </User>

66)  </ModifyUsers>

67)  </AnalyzerAdmin>

XML File Format Explanation
The following is a line-by-line description of the above file:

1) Identifies the XML version and character encoding of the XML file. This must 
be the first line of all .aru import files.
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2) Identifies Hyperion Analyzer Administration Tool as the target application. 
This must be the second line of all .aru import files.

3) Begins the request to create one or more user groups.

4,5) Identifies the roles to be assigned to each newly-created user group in the 
CreateUserGroups request.

6,7) Identifies the user groups to be created. The Name property must be a unique 
group name. The description property is optional and may be omitted.

8) Identifies a role to be assigned to GroupB in addition to the default roles defined 
in lines 4 & 5.

9) Ends the definition of GroupB.

10) Identifies a third user group to be created.

11) Ends the CreateUserGroups request.

12) Begins a request to create one or more users. A default password of “Pwd” will 
be assigned to each new user that does not specifically identify a password. When 
the default password is omitted, a password must be given in each specific user 
definition. Each new user will be required to change their password upon login 
unless the value of ChangePwd is overridden in a specific user definition. Each 
newly created user will be assigned the same user properties as the existing User50 
user. TemplateProperties are optional and may be omitted.

13) Identifies the default user group that will be assigned to each newly created 
user within the CreateUsers request. Multiple user groups may be specified by 
adding additional DefaultUserGroup lines.

14) Identifies the default role that will be assigned to each newly created user 
within the “CreateUsers” request. Multiple roles may be specified by adding 
additional DefaultRole lines.

15) Identifies the new user to be created. The LoginID must uniquely identify the 
new user.  “Name” is an optional property that may be omitted.

16) Identifies another new user and overrides the default password information 
provided on line 12.

17) Identifies another new user and overrides the user properties information 
provided on line 12. This user will have the same properties as the existing User27 
user.

18) Identifies the user group to be assigned to User3 in addition to the default 
group defined in line 13. 
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19) Identifies the role to be assigned to User3 in addition to the default role defined 
in line 14.

20) Ends the User3 definition.

21) Ends the create users request.

22) Begins the delete users request.

23,24) Identifies the users to be deleted.

25) Ends the delete users request.

26) Begins the delete user groups request.

27,28) Identifies the user groups to be deleted.

29) Ends the delete user groups request.

30) Begins a request to modify one or more user accounts. The only supported 
account modifications using the import functionality are adding/deleting points of 
view and adding/deleting personal variables.

31) Identifies the user whose account is being modified.

32) Begins the request to create a new personal variable. The personal variable 
name, database name, and the database dimension name to which the variable 
applies must be provided. If a personal variable of the same name already exists 
for the database. The operation is aborted. The personal variable is applied to all 
global and personal databases with the specified name.

33,34) Identifies the members within the dimension that make up the personal 
variable, as well as the selection mode for each member. Valid selection modes 
are: MEMBER, CHILDREN, DESCENDANT, PARENT, ANCESTOR, 
SIBLING, DIMBOTTOM, DIMTOP, LEVEL, GENERATION, and PREVIOUS. 
The default selection mode is MEMBER.

35) Ends the add personal variable request.

36) Begins the new request to create a personal variable.

37) Identifies the member with a selection mode of PREVIOUS. In this instance a 
previous count must be provided to identify the number of previous members are 
to be included with this member.

38) Ends the add personal variable request.

39) Begins the request to create a new point of view. The point of view name, and 
database name must be provided. The user may optionally indicate whether this 
point of view should be active. The default active value is “False”. If a point of 
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view of the same name already exists for the database. The operation is aborted. 
The point of view is applied to all global and personal databases with the specified 
name.

40) Identifies the axis to which the following dimension selections are to be 
applied. Valid axes are: Rows, Columns, Pages, and Filters. The default axis is 
Filters.

41) Identifies dimension to be placed on the axis.

42,43) Identifies the members within the specified dimension to be placed on the 
axis. The valid selection modes are the same as those identified on line 33,34. Note 
that on line 42 the default selection mode is MEMBER.

44) Ends the dimension specification.

45-47) Identifies another list of members to be place on the axis identified on line 
41.

48) Ends the selection of members for the axis.

49-58) Identifies the members to be included on two more axes.

59) Ends the point of view definition.

60) Request to delete the personal variable named YearPV which is defined 
against database localhost:Sample:Basic.

61) Request to delete the point of view named AnotherPOV which is defined 
against database localhost:Sample:Basic.

62) Ends the modifications to the specified user.

63-65) Modification of another user account.

66) Ends the modify user request.

67) Ends the Administrator requests.

Importing Authenticated Users
With the advent of the new Hyperion Analyzer authentication methods, 
Administrators have the option of importing users and specifying the 
authentication method used to validate them during log on.

To enable this functionality, Administrators must enter fully qualified usernames 
in their XML file, as in the following example:
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12) <CreateUsers Password="Pwd" ChangePwd="true" 
TemplateProperties="User50">

13)  <DefaultUserGroup Name="GroupA"/>

14)  <DefaultRole Name="Power User"/>

15)  <User LoginID="June" Name="TestName"/>

16)  <User LoginID="Essbase\Nikko" Password="Pwds" ChangePwd=
"false"/>

17)  <User LoginID="External:ntlmSvrname\Franz" 
TemplateProperties="User27">

18)  <UserGroup Name="Administrators"/>

19)  <Role Name="Power User"/>

20)  </User>

21)  </CreateUsers>

On line 15: In the absence of any authentication method, June will be authenticated 
using by default Analyzer authentication.

On line 16: By declaring Essbase authentication and a backslash(\), the user ID 
Nikko will be created and authenticated using the defined Essbase authentication 
server.

On line 17: By declaring the external authentication method and the external 
authentication provider (separated by a colon (:) and followed by a backslash (\)), 
the user ID Franz will be created and authenticated using the specified external 
authentication provider.

Note: Important! To import authenticated users, all authentication methods must be 
implemented. See Chapter 4, “Managing Security and Access”, for more information.

Exporting an .ARU XML File
Administrators have the same options for exporting Hyperion Analyzer repository 
information 

➤ To export an .aru XML file using Administration Tools:

1. Select File | Export from the Administration Tools Menu bar.

The Open dialog box is displayed

2. Navigate to an output location for the .aru file.

3. Click OK.
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The file is exported to the specified location.

Web Publishing Batch Utility
Hyperion Analyzer enables users to convert a currently displayed report, or and 
entire report group to HTML, by specifying a JSP template.

This Web Publishing process can also be automated using a command line batch 
utility that converts report groups to HTML as scheduled.

Prerequisites for Web Publishing

Hyperion Analyzer Standalone (Windows) Client
Administrators are required to install a license of the Hyperion Analyzer 
standalone client on a Windows client machine.

Report Properties
Report properties can be defined that direct Web Publishing. When no report 
properties are set, default values are used.

Accessing Report Properties

➤ To display the Report Properties dialog box, do one of the following tasks:

● Right-click the Report Tabs bar and select Properties.

● Click the toolbar Open button, to display Report Manager, and then select 
Properties from the report name right-click menu.

JSP Templates
Hyperion Analyzer converts reports to Web pages using pre-defined Java Server 
Pages (JSP) templates.

All templates must be located in your application server’s Web Publishing 
template sub-directory (wp_templates).
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When no JSP template file is specified, Analyzer defaults to using the 
report_publish.jsp template in the \webapps\Analyzer6_Server\templates 
sub-directory.

Publish To
HTML output location is defined by the Publish To report property.

When using the Batch Utility, the default output file (Publish To) is the application 
server’s Web Publishing Output sub-directory (wp_output) when no other 
directory is specified.

Creating the Web Publishing XML File
Users are required to define an XML that specifies the parameters and arguments 
used to automate Web Publishing.

The following code is an example of a Web Publishing XML file:

1 <?xml version="1.0" encoding="UTF-8" ?>

2 <AnalyzerExport>

3 <ExportItem URL=
"http://localhost/Analyzer6_Server/Dispatcher" UserName=
"system" Password="password"  GroupName="systemGroup" 
ReportName="" Overwrite="" />

4 </AnalyzerExport>

Web Publishing XML File Explanation
The following is a line-by-line description of the above file:

1) Identifies the XML version and character encoding of the XML file. This must 
be the first line of all Web Publishing files.

2) Indicates the start of a Web Publishing declaration.

3) Identifies the subject to be exported to HTML using the following attributes:

● URL=the fully qualified path to the Dispatcher in the web app directory.

● UserName=A valid Hyperion Analyzer user ID.

● Password=A valid password for the user name.
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● GroupName=The name of the Hyperion Analyzer report group 
containing the reports to be exported as HTML.

● ReportName=The name of the report to be exported as HTML.

Note: In the absence of a specified ReportName attribute, the entire report group is 
exported as HTML.

4) Indicates the end of a Web Publishing declaration.

Locating the Web Publishing XML File
The Web Publishing XML file must be accessible to the installed Hyperion 
Analyzer Standalone (Windows) client.

Running the Web Publishing Batch Utility

➤ To export the items specified by the Web Publishing XML file using the command 
line, enter the following text at the command line of the Hyperion Analyzer drive:

BatchExport.bat [filename.xml]
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Authentication Options
Hyperion Analyzer supports three methods for validating user IDs and logons:

● Analyzer Authentication

● Essbase Authentication

● External Authentication

Authentication methods are not mutually exclusive. Administrators may elect a 
combination of methods and set an order of precedence.

Administrators must evaluate the advantages and disadvantages of each of these 
methods before setting authentication methods.

Analyzer Authentication
Native Hyperion Analyzer authentication is always available to every valid 
Hyperion Analyzer user.

Analyzer authentication validates the user against known user IDs and passwords 
in the Hyperion Analyzer repository.

Administrators using this authentication method have the additional option of 
setting Hyperion Analyzer passwords to expire at specified interval of days.

The Hyperion Analyzer Batch Import/Export utility enables administrators to 
compose an .ARU XML file that automates the creation and modification of users 
and user groups in the Hyperion Analyzer repository. See Chapter 3, “Hyperion 
Analyzer Utilities”, for more information.
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Essbase Authentication
When Hyperion Essbase authentication is enabled, Hyperion Analyzer uses the 
specified Hyperion Essbase server to validate the user ID and password for login. 
This method requires the administrator to specify the server name or server IP 
address.

Essbase authentication is summarized by the following table:

Table 4: Essbase Authentication Summary

External Authentication
When external authentication is enabled, Hyperion Analyzer uses a centralized, 
independent authentication provider to validate the user ID and password.

Hyperion Analyzer supports three external authentication providers:

● Lightweight Directory Access Protocol Directory (LDAP)

● Microsoft Active Directory, Windows 2000 sp1 (MSAD)

● Microsoft Windows NT LAN Manager 4.0 (NTLM)

Hyperion Analyzer supports four external authentication platforms:

● Microsoft Windows NT 4.0

● Microsoft Windows 2000

● Microsoft Windows XP

Essbase Authentication Action Hyperion Analyzer Response

Hyperion Essbase validates the user and 
the existence of a Hyperion Analyzer 
user profile.

Hyperion Analyzer logs in the user.

Hyperion Essbase validates the user but 
cannot validate the existence of a 
Hyperion Analyzer user profile.

Hyperion Analyzer assigns the 
Hyperion Essbase user ID and password 
to a new user profile (created using a 
default user group).

Hyperion Essbase cannot validate the 
user.

Hyperion Analyzer displays a failed 
login message.
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● UNIX

Note: NTLM implementations on UNIX platforms require NTLM remote server 
to be installed on a Windows NT or Windows 2000 server.

Single Sign-on
One of the benefits of external authentication is single sign-on. Externally 
authenticated users are granted access to multiple Hyperion applications after 
logging on only once. After external authentication, an encrypted token containing 
the user ID and password is passed among Hyperion applications and is used to 
automatically re-authenticate the user.

Setting Authentication Methods
Authentication methods are set, in whole or in part, using the Hyperion Analyzer 
Administration Tools client.

Setting Analyzer Authentication

➤ To initiate Analyzer Authentication:

1. Start Hyperion Analyzer Administration Tools.

1. Select Edit > Authentication Services.

The Authentication Services dialog box is displayed. It contains a General tab 
and three authentication method tabs.

2. Select the General tab.

Within the Select Domain Types group the Analyzer check box is selected. 
The checkbox is disabled, so that users cannot change this selection. This 
ensures that Analyzer authentication is always available.

Within the Default Domain Type group the Analyzer option is selected. This 
sets Analyzer authentication as the default in the Login dialog box.

3. Select the Analyzer tab.

This tab features a password expiration setting.

4. If you want to set passwords to expire after a specified interval of days, click 
the check box and enter a whole number in the entry field.
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5. Click OK.

Setting Essbase Authentication

➤ To initiate Essbase Authentication:

1. Start Hyperion Analyzer Administration Tools.

1. Select Edit > Authentication Services.

The Authentication Services dialog box is displayed. It contains a General tab 
and three authentication method tabs.

2. Select the General tab.

Within the Select Domain Types group the Analyzer check box is selected. 
This checkbox is disabled, so that users cannot change this selection. This 
ensures that Analyzer authentication is always available.

3. Select the Essbase check box.

This selection enables the Essbase tab.

4. Select a default domain type, by clicking an enabled option button in the 
Default Domain Type group.

If you want Essbase to serve as the default authentication domain, select 
Essbase in the Default Domain Type group. This sets Essbase authentication 
as the default in the Login dialog box.

If you want Analyzer to serve as the default authentication domain, select 
Analyzer.

5. Select the Essbase tab.

6. Enter the server domain name or the IP address in the Essbase Server field.

7. Select a defined Hyperion Analyzer user group from the Default User Group 
drop down list box.

When Hyperion Essbase can validate the user, but cannot determine whether 
a Hyperion Analyzer user ID has yet been created, a new user ID is created 
using the Essbase user ID and password. The privileges of the specified 
Default User Group are assigned to the new user ID.

Hyperion Analyzer is delivered with an Administrators user group that assigns 
all the privileges normally given to the system administrator.
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If the none option is selected, a new user ID is created, but the user is not able 
to use Hyperion Analyzer until an Administrator assigns the new user ID to a 
defined Hyperion Analyzer user group.

For more information on creating user groups and assigning user 
roles/privileges, see the Hyperion Analyzer Administration Tools Online 
Help.

8. Click OK.

Configuring External Authentication
Configuring external authentication has been broken down into the following 
processes:

Configuring External Authentication Overview
1. Satisfy pre-requisites

2. Install Hyperion Analyzer

3. Define Hyperion Analyzer user groups

4. Edit the CssConfig.xml file

5. Locating the CssConfig.xml file

6. Copy archives to the application server JRE

7. Specify the configuration file location

8. Map groups to Hyperion Analyzer user groups

Pre-requisites for External Authentication
Before you can implement external authentication, the following determinations 
must be made:

● Is the security platform implemented from an application or an application 
server?

● Which platforms and authentication providers will be used in external 
authentication?
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● If you are considering implementing an NTLM provider on a UNIX platform, 
is an NTLM remote server installed on a Windows NT or Windows 2000 
server?

Installing Hyperion NTLM Remote Server to Support 
UNIX applications

➤ To install Hyperion NTLM Remote Server in support of UNIX applications, 
perform the following steps:

1. Install Hyperion NTML Remote Server on the Microsoft Windows NT/2000 
server (Run setup.exe).

The installation program, setup.exe, is provided with Hyperion application 
installation software.

2. Accept the terms of the license agreement and click Next.

3. Click Next on the Welcome page.

4. Identify a destination location for the NTLM Remote Server, and click Next.

5. Enter the host name and port number for the machine hosting the NTLM 
Remote Server, and click Next.

6. If you use Secure Sockets Layer (SSL) with your NTLM deployment, select 
the option to support SSL and click Next.

7. In the Start Copying Files dialog box, click Next to begin the installation.

8. Click Finish to complete the installation.

9. To run the remote server, select Start > Programs > Hyperion Solutions > 
NTLM Remote Server > Run NTLM Remote Server.

Note: Combining the NTLM remote server with the NTLM Primary Domain 
Controller is not recommended, but the NTLM remote server machine needs to be 
in the same domain as the NTLM Primary Domain Controller.

Note: Ensure that the JRE installed on the UNIX application server is also installed 
on the NTLM Remote Server.
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Required NTLM User Rights
The NTLM user account on which the application server runs requires the access 
described below. Privileges must be established on the machine running the 
application server (as opposed to the NT domain machine):

● Grant “Access the computer from the network” rights

● Grant “Act as part of the operating system” rights

● End users must be domain users rather than local Windows users.

Hyperion Analyzer Installation and External 
Authentication Components

Hyperion Analyzer installs the following external authentication components in 
the course of installation:

● A generic CssConfig.xml file is installed in the ..\hyperion\analyzer\conf 
directory.

● Java Cryptography Extension (JCE) archives are installed in the 
..\hyperion\analyzer\css directory.

Defining Hyperion Analyzer User Groups
Hyperion Analyzer privileges are assigned by user group. All users command the 
privileges given to the user groups to which they belong.

If your Hyperion Analyzer implementation already features defined user groups, 
you can proceed to the next procedure.

➤ To create new Hyperion Analyzer user group profiles in Hyperion Analyzer 
Administration Tools, perform the following steps:

1. Do one of the following tasks:

● Right-click the User Groups folder and select New User Group from the 
right-click menu.

● From the Menu bar, select File > New > New User Group.

An empty user group profile is displayed in the Management panel. The 
General tab is displayed by default.

2. Enter a user group name in the Name field.
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3. Optionally, you can enter a user group description in the Description field.

4. Click the Roles tab.

Hyperion Analyzer has four defined roles:

● Administrator - Unrestricted

● Power User

● Interactive User

● Information Consumer - Read-only access

Detailed descriptions of the permissions provided through each of these roles 
is provided by Hyperion Analyzer Administration Tools Online Help.

Note: Assign these roles conservatively. There are fewer consequences for 
expanding permissions than restricting permissions.

5. Select a role in the Available panel.

6. Click the right arrow button, to move the role definition to the Assigned panel.

The selected role has been assigned to all users of the user group. Permissions 
are cumulative for multiple role elections.

7. Click the Apply button.

8. Click OK.

A user group profile has not been created until the Apply button is clicked and 
the Log panel confirms success.

This process must be repeated for each user group. The number of user groups 
required is determined by the roles and permissions required for your 
implementation.

Editing the CssConfig.xml File
External authentication is managed using a configuration XML file that specifies 
the platforms and authentication providers of your specific implementation. Users 
must establish the components used in support of external authentication, and then 
coordinate them by editing the XML file.
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Pre-existing Configuration Files
Before you edit the CssConfig.xml file delivered with Hyperion Analyzer, you 
must determine whether your enterprise has defined an external authentication 
configuration file for previously installed Hyperion products.

Note: If this file already exists, do not overwrite it.

The Hyperion Analyzer external authentication configuration file is called 
CssConfig.xml. Because files can be renamed, you cannot depend on a simple file 
search to determine the existence of an external authentication configuration file.

Editing Configuration File Overview
If no other external authentication configuration file exists, you can edit the 
generic CssConfig.xml file installed in the ..\hyperion\analyzer\conf directory.

In editing the XML file, you will specify the following information:

● The sequential search order for accessing multiple external authentication 
provider types

● The type, name, parameters, and number of external authentication providers

● The duration in minutes that authentication tokens persist when passed to 
Hyperion applications (before timing out)

● Logging parameters

Opening the Configuration File

➤ To edit the external authentication configuration file, open the external 
authentication configuration file (CssConfig.xml) in Microsoft WordPad Text 
Editor.

Configuring the Provider Search Order
The search order provides the external authentication mechanism the ability to 
access multiple providers in a sequential manner. Search order must be defined 
even if there is only a single authentication provider. In this case, the search order 
property has a single entry.
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➤ To define the provider search order:

1. Locate the <searchOrder> tag in the configuration file.

Each supported external authentication provider is listed as an element of the 
search order tag:

<searchOrder>

  <el>ntlmServer</el>

  <el>ldapServer</el>

  <el>msadServer</el>

</searchOrder>

The order of the elements determines the order in which each external 
authentication provider is searched in an attempt to validate users during log 
on.

Hyperion recommends placing the provider for most users of Hyperion 
applications first in the search order.

2. Cut and paste the elements, to reorder them.

Providers may be added or removed as needed.

The search order element must be named exactly the same as the name you 
specify in subsequent provider definitions.

To expedite editing, you can comment out elements using the following 
syntax:

  <!-- el>ldapServer</el -->

3. Add, remove or comment out elements as needed.

4. To save your changes to the configuration file, select File > Save from the 
WordPad Menu bar.

Configuring an NTLM Provider
You must modify the configuration file to support NTLM external authentication 
providers, if you are implementing them.

➤ To define NTLM external authentication providers, perform the following steps:

1. Locate the NTLM provider tags in the configuration file.

The NTLM tag is <ntlm name=”ntlmAuth1”>.
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2. Edit the name value to correctly reflect the name of the external authentication 
provider. 

Remember that the string value must be inside quotation marks, and must be 
identical to the name specified in the search order tag.

The following parameters can be set for each defined provider. Do not delete 
parameter values only. In the absence of values, defaults may be used. To 
delete the impact of a parameter, comment it out, or delete the entire tag set 
(from <> to </>).

● trusted:     The trust relationship of this provider

● domain:     The NTLM domain against which to authenticate

● maxSize:     Maximum allowable number of users or groups returned.

● remoteServer:  This section should be included when authenticating from 
UNIX

Note: If you support Hyperion applications only on Microsoft Windows 
platforms, delete the content of the <remoteServer> tags, as their 
configuration applies only to support for UNIX clients accessing information 
stored in an NTLM provider.

● location:     Location providing the remote RMI authentication for NT

The configuration file contains generic provider definitions to expedite your 
changes. Edit the parameters as follows:

3. Edit the <trusted></trusted> tags.

If the specified provider is a trusted provider, leave the value true. A password 
is not present or required in the user authentication token, when the value is 
true. Users still must log in with a user name and password, but the password 
is not stored in the token.

If the specified provider is not a trusted provider, replace the value with false. 
A password is required in the user authentication token, when the value is 
false.

If the entire tag is deleted, the default value of true is used.

4. Edit the <domain></domain> tags.

The NTLM provider is responsible for operations on the specified domain. 
When no value is supplied for the domain element, the NTLM provider 
performs operations on all trusted domains.
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5. Edit the user <maxSize></maxSize> tags.

Replace the generic value with the maximum number of entries that can be 
returned in a query.

If the entire tag is deleted, the default value of 100 is used. Do not delete the 
tag values solely. Setting the value to 0 prevents rows from being returned to 
the application.

6. To save your changes to the configuration file, select File > Save from the 
WordPad Menu bar.

Configuring the NTLM Remote Server in Support of 
UNIX Applications
If you are implementing an NTLM provider on a UNIX platform, you must 
identify the NTLM remote server installed on a Windows NT or Windows 2000 
server.

➤ To configure the Hyperion NTLM Remote Server in support of UNIX 
applications, perform the following steps:

1. Locate the <remoteServer> tag in the configuration file NTLM provider 
definition.

2. Change the value between the <location></location> tags to indicate the 
URL of the Hyperion NTLM Remote Server.

You may be required to un-comment the lines surrounding the tag and values.

3. To save your changes to the configuration file, select File > Save from the 
WordPad Menu bar.

Configuring an LDAP or MSAD Provider
You must modify the configuration file to support LDAP and MSAD external 
authentication providers, if you are implementing them.

➤ To define LDAP and MSAD external authentication providers, perform the 
following steps:

1. Locate the LDAP and MSAD provider tags in the configuration file.

The LDAP tag is <ldap name=”ldapAuth1”>.
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The MSAD tag is <msad name=”msadAuth1”>.

2. Edit the name value to correctly reflect the name of the external authentication 
provider. 

Remember that the string value must be inside quotation marks, and must be 
identical to the name specified in the search order tag.

The following parameters can be set for each defined provider. Do not delete 
parameter values only. In the absence of values, defaults may be used. To 
delete the impact of a parameter, comment it out, or delete the entire tag set 
(from <> to </>).

● trusted:     The trust relationship of this provider

● url:     Provider server identification

● userDN:     (Optional) ID of user with directory access

● password:     (Optional) Password of user with directory access

● authType:     Authentication type

● authProtocol:     (Optional) Authentication Protocol

● maxSize:     Maximum allowable number of users or groups returned.

● identityAttribute:     Attribute which specifies the users identity

● user:     Attributes defining user aspects.

Note:         loginAttribute is used to identify the users login name.

● group:     Attributes defining group aspects.

The configuration file contains generic provider definitions to expedite your 
changes. Edit the parameters as follows:

3. Edit the <trusted></trusted> tags.

If the specified provider is a trusted provider, leave the value true. A password 
is not present or required in the user authentication token, when the value is 
true.

If the specified provider is not a trusted provider, replace the value with false. 
A password is required in the user authentication token, when the value is 
false.

If the entire tag is deleted, the default value of true is used.
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4. Edit the <url></url> tags.

Replace the tag value with the URL of the external authentication provider 
location. You must include the domain component attributes (DCs) in the 
URL. For example:

ldap://ldap_server:389/DC=company,DC=com

Note: Ensure that there are no empty spaces in the URL.

5. Edit the <usderDN></userDN> tags and <password></password> tags.

Replace the generic values with information from valid user account with 
read-only access to the directory stores.

If you want to provide anonymous access, delete both tag definitions. Do not 
delete the tag values solely.

Next you will structure the user definition information for external 
authentication.

6. Edit the user <maxSize></maxSize> tags.

Replace the generic value with the maximum number of entries that can be 
returned in a query.

If the entire tag is deleted, the default value of 100 is used. Do not delete the 
tag values solely. Setting the value to 0, enables a result set size of unlimited. 
This is not advisable, as extremely large result sets quickly consume memory 
allocations.

7. Edit the user <authProtocol></authProtocol> tags.

Replace the generic value with additional security protocols you are using to 
secure data transmission to and from the external authentication provider.

The only valid value for this tag is ssl.

If you are not using Secure Sockets Layer, delete the tags completely.

If you are using Secure Sockets Layer, also complete the following tasks:

● On the directory server, ensure that a certificate is installed and available.

● On the Java Virtual Machine that runs your application, create a 
certificate database if one does not exist.

● On the Java Virtual Machine that runs your application, trust the 
Certificate Authority (CA) that issues the server certificate.
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The security platform uses the LDAP service provider from SUN to 
authenticate users stored externally in an LDAP-compatible directory. The 
LDAP service provider runs on the Java Virtual Machine for your application. 
When SSL is used as the secure medium to connect to the directory server, the 
security platform LDAP service provider uses Java Secure Socket Extension 
software for SSL support.

8. Edit the user <identityAttribute></identityAttribute> tags.

Replace the generic value with the unique identifier attribute of the directory. 
The attribute may be the DN, or a custom attribute such as employee_ID. 
When the identityAttribute tags are deleted the default value is dn.

9. Edit the user <url></url> tags.

Replace ou=People with the directory server branch that contains user entries. 
For example (if users are stored in a directory named People):

<user>
  <url>ou=People</url>
</user>

The user url property is relative to the URL specified for the provider. If you 
want the provider to search the whole directory, delete the <url></url> tags. 
Do not delete the tag values solely.

10. Edit the user <loginAttribute></loginAttribute> tags.

Replace the generic value with the unique entry attribute of the directory. The 
attribute may be part of the DN, such as cn or uid, or a custom attribute such 
as employee_id. When the loginAttribute tags are deleted, the default is cn.

For example, if users use the common name attribute and are identified by cn=
UserName, the following syntax is used:

<user>
  <loginAttribute>cn</loginAttribute>
</user>

The sample above is correct if it is true that all user names are identified by 
cn=UserName.

The above example highlights a subset of the DN. However, the 
loginAttribute property can instead refer to an attribute under the directory 
node for the user. For example, loginAttribute can point to uid.

11. Edit the user <fnAttribute></fnAttribute> tags.
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Replace the generic value with the attribute associated with first-name entries 
in the directory. If the <fnAttribute> </fnAttribute> tags and their contents are 
deleted, the default value for the first-name attribute is givenname.

12. Edit the user <snAttribute></snAttribute> tags.

Replace the generic value with the attribute associated with last-name entries 
in the LDAP directory. If the <snAttribute></snAttribute> tags and their 
contents are deleted, the default value for the last-name attribute is sn.

13. Edit the user <emailAttribute></emailAttribute> tags.

Replace the generic value with the attribute mapped to e-mail addresses that 
is stored in your corporate directory.

If the <emailAttribute> </emailAttribute> tags and their contents are deleted, 
the default value is mail.

14. Edit the user <objectclass></objectclass> tags.

You may add <entry></entry> tags and values if your corporate directory 
schema requires specialized object classes to describe users, and those object 
classes are not present in the existing entries.

The provided (default) user object classes for LDAP are person, 
organizationalPerson, and inetOrgPerson.

The provided (default) user object classes for Active Directory are person, 
organizationalPerson, and user.

Next you will structure the group definition information for external 
authentication.

15. Edit the group <url></url> tags.

Replace ou=Groups with the directory server branch that contains group 
entries. For example (if users are stored in a directory named Groups):

<group>
  <url>ou=Groups</url>
</group>

The user url property is relative to the URL specified for the provider. If you 
want the provider to search the whole directory, delete the <url></url> tags. 
Do not delete the tag values solely.

16. Edit the group <nameAttribute></nameAttribute> tags.
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Replace the generic value with the attribute in the corporate directory through 
which a group entry can be discovered. The default value is cn if the 
<nameAttribute> section is deleted.

For example (if group names containing the relevant user entries are using the 
Common Name attribute):

<group>
  <nameAttribute>cn</nameAttribute>
</group>

17. Edit the group <objectclass></objectclass> tags.

You may add <entry></entry> tags and values if your corporate directory 
schema requires specialized object classes to describe groups, and those object 
classes are not present in the existing entries.

The provided (default) group object classes for LDAP are 
groupofuniquenames?uniquemember and groupOfNames?member.

The provided (default) group object class for Active Directory is 
group?member.

For additional entries you make, the <entry> tag values must be of the format 
ObjectClassName?AttributeName

For example (where group is the name of the objectClass and member is the 
attribute that holds the distinguished Name of the member of this group):

<group>
  <entry>group?member</entry>
</group>

18. To save your changes to the configuration file, select File > Save from the 
WordPad Menu bar.

Configuring Token Timeout
When an externally authenticated user logs in to a Hyperion application, a token is 
generated to contain the login credentials. You can configure the token to expire 
after a specified number of minutes, instead of the default of 480 minutes (eight 
hours).

➤ To define the length of time a token remains valid, perform the following steps:

1. Locate the <token> tag in the configuration file.
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2. Enter the number of minutes required to pass before a user is prompted to 
authenticate again between the <timeout></timeout> tags.

<timeout>60</timeout>

3. To save your changes to the configuration file, select File > Save from the 
WordPad Menu bar.

Configuring Preferred Logging Priority

➤ To configure the error level setting for applications supporting external 
authentication, perform the following steps:

1. Locate the <logger> tag in the configuration file.

2. Change the error reporting value from DEBUG to the level of 
authentication-related error messages that you want the application to log 
between the <priority>DEBUG</priority> tags.

The following values are cumulative and include the error messages of the 
subordinate error levels.

DEBUG - Include all information for the purposes of debugging.

INFO - Include status information for select operations and requests.

WARN - Only include cautionary information for select operations and 
requests.

ERROR - Only include errors pertaining to failed operations and requests.

FATAL - Only include errors that result in disconnection.

3. To save your changes to the configuration file, select File > Save from the 
WordPad Menu bar.

Copying Archives to the Application Server JRE

➤ Copy the following Java Cryptography Extension (JCE) archives from the 
..\hyperion\analyzer\css directory to the application server Java Runtime 
Environment \lib\ext directory:

● jce1_2_2.jar

● local_policy.jar

● sunjce_provider.jar
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● US_export_policy.jar

Note: If these files already exist at this location, do not overwrite them.

Specifying the Configuration File Location
Because paths for supported application servers vary, you must specify the path to 
the edited CssConfig.xml file.

➤ To specify the CssConfig.xml file path, perform the following steps:

1. Launch Hyperion Analyzer Administration Tools.

2. Select Edit > Authentication Services from the Administration Tools menu 
bar.

The Authentication Services dialog box is displayed. It features a General tab 
and three authentication method tabs.

3. Click the General tab to make it the current tab.

Notice that inside the Select Domain Types group that the Analyzer check box 
is selected. Notice also that the checkbox is disabled, so that users cannot 
change this selection. This ensures that Analyzer authentication is always 
available.

The Essbase check box may or may not be selected, depending on your 
implementation.

4. Click the External check box.

Notice that this selection enables the External tab.

5. Select a default domain type, by clicking an enabled option button in the 
Default Domain Type group.

If you want external authentication to serve as the default authentication 
domain, click the External option button in the Default Domain Type group. 
This sets external authentication as the default in the Login dialog box. You 
must also specify the a default authentication server on the External tab.

If you want Analyzer to serve as the default authentication domain, click the 
Analyzer option button.

6. Click the External tab to make it the current tab.

7. Click the Set Configuration File button.
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The External Authentication dialog box is displayed.

8. Enter the fully qualified path to the edited CssConfig.xml file (that you copied 
to the ..\hyperion\analyzer\conf application server directory).

9. Click OK.

The specified path displays in the External tab Configuration File field.

10. Click the Default Domain Server drop down list box, and select one external 
authentication server to serve as the default.

This setting, in conjunction with the Default Domain Type selection on the 
General tab, sets a specific external authentication provider as the default in 
the Login dialog box.

This specific procedure is completed, but do not close the Authentication 
Services dialog box yet.

Mapping Groups to User Groups
Externally authenticated users must be mapped to Hyperion Analyzer user groups, 
so that Hyperion Analyzer can appropriately control use and access to the 
Hyperion Analyzer system.

➤ To map defined directory server groups to Hyperion Analyzer groups, perform the 
following steps:

1. In the Authentication Services dialog box External tab, click the Group 
Mappings Server Name drop down list box, and select a defined external 
authentication provider.

This points the Group Mappings table to the external authentication providers 
specified by the CssConfig.xml file.

The directory server groups for the specified provider display on the left side 
of the table.

2. Do one of the following:

● Click the Mapped Analyzer Groups cell to the right of a Directory 
Server Groups cell, and select a defined Hyperion Analyzer user group 
from the drop down list box.

● Right-click the Mapped Analyzer Groups cell to the right of a Directory 
Server Groups cell, and select Map to Group and a defined Hyperion 
Analyzer group from the sub-menu.
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Your selection displays in the Mapped Analyzer Groups cell.

3. Repeat this process until every directory server group is mapped to a Hyperion 
Analyzer user group.

4. If applicable, click the Group Mappings Server Name drop down list box, 
select a different external authentication provider, and repeat the process of 
mapping directory server groups to a Hyperion Analyzer user groups.

5. When all groups for all external authentication providers have been mapped to 
Hyperion Analyzer user groups, click OK.

Secure Socket Layer
Hyperion Analyzer supports the SSL 3.0 security protocol. The SSL record 
protocol encapsulates other protocols that enable client-server authentication and 
establish encrypted data transfer.

Lockout Recovery
Do not forget the Administrator password, as this prevents administration until 
another user with an Administrator role (privileges) resets the password.

In the event that you are unable to log in as an administrator because of lost or 
forgotten passwords, Hyperion Analyzer technical support may be able to recover 
the system password. However, since there is no “back door” into Hyperion 
Analyzer, recovering system passwords is difficult.
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Analyzer.Properties File
The Analyzer.properties file contains variables controlling Hyperion Analyzer 
functionality.  Administrators need to modify the file in support of their specific 
implementations.

Those using the Apache Tomcat 4.0.1 application server can find the 
Analyzer.properties file at:

C:\Hyperion\analyzer\catalina\webapps\Analyzer6_Server\WEB-INF\
conf

Those using the IBM WebSphere application servers can find the 
Analyzer.properties file at:

C:\Hyperion\appserver\hosts\default_host\Analyzer6_Server\Analy
zer6\classes

Editing the Analyzer.properties File

Controlling the Result Set
Users and system administrators can set row limits to control the size of both the 
relational and OLAP query result set.  This protects server and network resources 
from being consumed unintentionally by very large query result sets.

The Relational Drill-through graphical user interface features a Max rows to return 
field that controls the number of rows returned during relational drill-through.

Other OLAP and relational row limits must be set in the Analyzer.properties text 
file.  The path to this text file varies by application server configuration.
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The Analyzer.properties file contains variables controlling the query result set in 
terms of rows:

● MaxDataCellLimit controls OLAP database connection query result set size.

● MaxJdbcCellCount controls relational database connection query result set 
size.

They are set by default as follows:

MaxDataCellLimit=50000

MaxJdbcCellCount=50000

➤ To change the upper bound for query result set size:

1. Stop the application server.

2. Edit the variables in a text editor and save your changes.

3. Restart the application server.

Updating the License Key Without Reinstalling
Users can update the number of licensed users or transition from evaluation to 
licensed use of Hyperion Analyzer without reinstalling the entire application suite.

Users receive new license keys from Hyperion by contacting customer support.  
For Web-based support, or to see complete information on available support 
options, visit the Hyperion Web site at: www.Hyperion.com 

The Analyzer.properties file contains variables controlling licensed use of 
Hyperion Analyzer:

● SingleUser-LicenseKey= indicates an individual license key.

● LicenseKey= indicates group license keys.

● LicenseKeyVersion=Analyzer6 indicates the version of Hyperion Analyzer

➤ To change the license key information:

1. Stop the application server.

2. Edit the variables in a text editor and save your changes.

3. Restart the application server.
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Identifying Hyperion Integrated Applications for Hyperion 
Analyzer

Users must define the Hyperion integrated applications that are available to 
Hyperion Analyzer users through the Related Content feature.

The Analyzer.properties file contains two variables enabling integrated Hyperion 
applications in Hyperion Analyzer:

● RelatedContent.Server.Name.0=<ServerDisplayName>

● RelatedContent.Server.URL.0=<TargetURL>

ServerDisplayName is the string value that displays in the Add Related Content 
dialog box.

TargetURL is the uniform resource locator used to launch the integrated Hyperion 
application.  The TargetURL must be in the following format:

http://<hostname:port>/<webAppURL>?<Application-specific parameters>

The application-specific parameters are defined by individual integrated 
applications.  The following are a few examples of application-specific 
parameters:

Hyperion Analyzer

sso_username=
$SSO_USERNAME$&sso_password$SSO_PASSWORD$&sso_token=
$SSO_TOKEN$

Hyperion Reports

sso_username=$SSO_USERNAME$&sso_password=$SSO_PASSWORD$

Hyperion Q&R

sso_token=$SSO_TOKEN$&AUTH_TYPE=secLDAP&APS_NAME=
hipserver3&path=%2f

Hyperion Central

sso_token=$SSO_TOKEN$&path=%2f
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Note: Replacement tags are used within the application-specific parameters so that 
user authentication information can be passed in a consistent way.  Available 
replacement tags are:

● $SSO_USERNAME$

● $SSO_PASSWORD$

● $SSO_TOKEN$

Hyperion Integrated Application Definition Examples

Note: Note the sequential numbering of definitions using a zero-based index!

RelatedContent.Server.Name.0=Hyperion Analyzer

RelatedContent.Server.URL.0=
http://server1/Analyzer6_Server/DirectoryServlet?sso_username=
$SSO_USERNAME$&sso_password$SSO_PASSWORD$&sso_token=
$SSO_TOKEN$

RelatedContent.Server.Name.1=Hyperion Reports

RelatedContent.Server.URL.1=
http://server2:8200/Reports/HRRepositoryXML.jsp?sso_username=
$SSO_USERNAME$&sso_password$SSO_PASSWORD$&sso_token=
$SSO_TOKEN$

External Authentication Requirements for Hyperion 
Integrated Applications
Hyperion integrated applications accessed through the Related Content feature 
require external authentication implementation.

In addition, the external authentication configuration file(s) must have identical 
entries for the external authentication provider.

In short, all applications must authenticate users using the same configuration file, 
or, in the case of multiple configuration files, the authentication provider entries 
must be identical.
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Configuring Essbase XTD Deployment Services (EDS)
The Analyzer.properties file supports variables enabling Essbase XTD 
Deployment Services (EDS).  This service enables access to clustered Essbase 
server configurations.

A cluster of Essbase servers is a set of servers running on different computers (or 
different CPUs, on multi-processor systems) that run copies, or replicas, of the 
same Essbase application, a single Essbase server that runs replicas of the same 
application, or a combination of both.

Users are encouraged to download and read the Essbase XTD Deployment 
Services Installation Guide for complete information on installing, configuring 
and using this service.
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Table 5: EDS Variables

Variable Description

UseEES=false UseEES=true prompts ADM to use EDS to access 
Essbase.

UseEES=false enables ADM to use the default JNI 
driver.

EESDriverName=
adm:thin:com.hyperion.ap.
ees.EESHssDriver

Specifies the EDS driver to ADM.  Do not modify 
this variable.

EESServerName=localhost Specifies the server running EDS.

EESLocale=en Specifies the locale for EDS.

EESDomain=essbase Specifies the domain for EDS.  Do not modify this 
variable.

EESORBType=TCPIP Specifies the valid ORB type for EDS.  Only TCPIP 
is supported.

EESPort=5001  Specifies the EDS communication port.  Specify a 
currently unused port.

EESUseConnPool=false

EESConnPerOp=false

Specifies the method ADM uses for EDS connection 
pooling.

A connection pool is a set of login sessions from 
EDS to an Essbase server.  EDS uses a connection 
pool to process requests for Essbase services.  There 
are 3 valid combinations of these properties:

EESUseConnPool=false  EESConnPerOp is 
ignored.

In this configuration, EES will not use any 
connection pooling.

EESUseConnPool=true  EESConnPerOp=false

Connection pooling is used, and the connection is 
held from the time the cube view is opened until it is 
closed.

EESUseConnPool=true  EESConnPerOp=true

Connection pooling is used, and the connection is 
released immediately after each operation.
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Note: The username and password used by the ADM-EDS driver must be valid on both 
the EDS server and the Essbase server.

Note: ChangePassword and SetPassword server actions attempt to modify both EDS 
and Essbase OLAP server passwords.  To be successful, the following properties must 
be set correctly:  olap.server.autoChangePassword=true.  Also the administrator user 
ID specified by the EDS_ES_HOME/bin directory (olap.server.admin.name=admin) 
must be different than the user ID being passed by the action.

Note: Two archives installed with EDS must be defined in the Hyperion Analyzer 
classpath:  ess_es_server.jar and ess_japi.jar.

Note: We do not recomment implementing EDS in conjunction with AIX platforms.

EESUseCluster=false  Enables EDS to use available Essbase cluster.

EESUseReportOption=
false  

This property should only be set to true if using 
Microsoft's JVM.

Variable Description
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HTML Web Client Templates
Templates are composed of conventional HTML and Hyperion Analyzer tags and 
actions. The following is a list of the templates used by the HTML Web Client:

● about.jsp

● analyze.jsp

● changepwd.jsp

● dblogin.jsp

● desktop.jsp

● dimbrowser.jsp

● edit.jsp

● error.jsp

● frame.jsp

● loggedout.jsp

● login.jsp

● relatedcontent.jsp

● report_publish.jsp

● report.jsp

● reportlist.jsp

● saveas.jsp
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Custom Templates
Once custom templates are created, you can optionally pre-compile the templates 
to enhance performance. Save the templates with other .jsp pages in the 
appropriate application server directory. In addition, some application servers 
require the .jsp pages be registered in the web.xml file. See your application server 
documentation to determine the requirement. This task is reserved for advanced 
users familiar with their application servers, as there are considerable differences 
between the supported application servers.

Template Tags
Template tags are parsed sequentially. In order to differentiate Hyperion Analyzer 
tags from HTML tags, the start and end tags are identified by the following syntax:

<hya: is the start of the tag and /> is the close of the tag.

For example:

<hya:TagName attribute1=”value1”, attribute2=”value2”, 
atrribute3=”value3”/>

<hya:About/>

Returns version number, copyright and server information, usually displayed in the 
Hyperion Analyzer About dialog box.

<hya:AllowActions/>

Enables drilling or Advanced member selection. The absence of this tag disables 
drilling in the Hyperion Analyzer HTML Web Client.

<hya:Analyze/>

Returns a URL to launch the Java Client

<hya:AuthServerList/>

Returns an HTML combo box that lists the available authentication servers.
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<hya:CalcList/>

Returns to the Hyperion Analyzer HTML Web Client a list of available server 
calcs. These server based calculations are often used to reconsolidate the database 
after edits have been posted.

Sample

<SELECT>

<OPTION>Default</OPTION>

</SELECT>

<hya:CancelDBLogin/>

Returns a URL to cancel the database login template.

<hya:CancelEdit/>

Returns a URL containing the actions to terminate the Edit Data mode without 
posting edits to the database.

<hya:CancelSave/>

Returns a URL to cancel the Save As template without saving the report.

<hya:CellBGColor/>

Defines the color of the cell background at the specified row and column.

Attributes

<hya:CellFGColor/>

Defines the color of the foreground text at the specified row and column.

Value Description

datasource The name of the data source found in the tree view of Designer.

row The integer representing a specified table row.

column The integer representing a specified table column.
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Attributes

<hya:CellValue/>

Returns the value of the cell at the specified row and column 

Attributes

<hya:DataPost/>

Appends the end of a Grid tag output data cell with the supplied data string.

Example

<hya:DataPost value=”</strong>”/>

Attributes

string: data

<hya:DataPre/>

Precedes a Grid tag output data cell with the supplied data string.

Attributes

string: data

Example

<hya:DataPre value=”<strong>”/>

Value Description

datasource The database connection name.

row The integer representing a specified table row.

column The integer representing a specified table column.

Value Description

datasource The database connection name.

row The integer representing a specified table row.
column The integer representing a specified table column.
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<hya:DataTD/>

Appends the <TD> HTML tag of a Grid tag output data cell with the supplied 
attribute string. Used to modify <TD> tag attributes for color, alignment, and other 
attributes. String data must specify valid HTML attributes for the <TD> tag, or the 
Web browser cannot render the cells.

Attributes

string: data

Example

<hya:DataTD value=”align=’right’”/>

<hya:DBList/>

Returns a combo box list of available database connections in the New Report 
template.

<hya:DBMessage/>

Returns status messages generated by the database.

<hya:DBName/>

Returns the database ID.

<hya:Desktop/>

Returns an HTML version of the Hyperion Analyzer HTML Web Client Desktop.

<hya:DimBrowserCurrentMember/>

Returns the member name of the current selected member in the Dimension 
Browser.

<hya:DimBrowserDefaultLabelMode/>

Returns a string for the default label mode of the selected dimension.
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String Values

Descriptions

IDs

Both - Descriptions and IDs

<hya:DimBrowserDimName/>

Returns the dimension name in the Dimension Browser.

<hya:DimBrowserEvent/>

Returns a URL to the server that sends the event to the Dimension Browser.

Attributes

event: The possible values of the name attribute for DimBrowserEvent:

Values

● UseDefault

● UseAlias

● UseID

● UseBoth

● Remove

Attribute Description

event The possible values of the name attribute for DimBrowserEvent:

UseDefault

UseAlias

UseID

UseBoth

Remove

RemoveAll

Apply

Cancel
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● RemoveAll

● Apply

● Cancel

Example

<hya:DimBrowserEvent event=”UseDefault”/>

<hya:DimBrowserLabelMode/>

Returns the current Label Mode string.

Value

0 - use id

1 - use alias

2 - use default

3 - use both

<hya:DimBrowserModeMenu/>

Returns an HTML table of the Selection Mode List that contains the following 
HTML anchors:

● Search

● Move Up

● Move Down

● Remove

<hya:DimBrowserSelectionList/>

Returns the HTML table that contains the member selections defined for the 
dimension being browsed.

<hya:DimBrowserShowModeMenu/>

Returns:
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true - The Dimension Browser Mode Menu is displayed

false - The Dimension Browser Mode Menu is hidden.

<hya:DimBrowserShowSearchDialog/>

Returns:

true - The Search Dialog table is displayed

false - The Search Dialog table is hidden.

<hya:DimBrowserTree/>

Returns the HTML table of the hierarchical tree of members for the selected 
dimension. Members that are selected in the tree are displayed in the Selection 
List.

<hya:DisplayTypes/>

Returns a list of available display types for the Hyperion Analyzer HTML Web 
Client.

Sample

<SELECT>

<OPTION>Spreadsheet</OPTION>

<OPTION>Bar Chart</OPTION>

</SELECT>

<hya:DrillOptions/>

Returns a list of available Hyperion Analyzer HTML Web Client drill options.

Sample

<SELECT>

<OPTION>Drill Down</OPTION>

<OPTION>Drill Up</OPTION>

<OPTION>Drill To Top</OPTION>
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</SELECT>

<hya:EditData/>

Returns the URL to initiate the Edit Data Mode of the current data object of the 
current report.

<hya:Filters/>

Returns a list of filter dimensions for the current data object of the current report.

<hya:GetProperty/>

Gets the true or false state of the defined attribute value.

Attributes

name: indicates the value that the GetProperty tag is obtaining the state for.

Value Description

showInfo Returns the true or false display state of Information Panel.

showFilters Returns the true or false display state of Filters.

showFonts Returns true if the Analyzer style or false if the Template style is 
employed for the fonts.

showMultiPage Returns the true or false display state of MultiPage.

isSaveAllowed Returns the true or false state of the current report if Save is 
allowed.

isReportLoaded Returns the true or false state of the current report if a report is 
loaded.

isEditAllowed Returns the true or false state of the current report if Edit mode is 
allowed.

isEssbase Returns the true or false state of the current data object in a report 
uses an Hyperion Essbase data connection

isRelational Returns the true or false state of the current data object in a report 
uses a relational data connection

isHFM Returns the true or false state of the current data object in a report 
uses an Hyperion Financial Management data connection
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<hya:Grid/>

Returns an HTML grid for the current page of the current data object of the current 
report.

<hya:HeadPost/>

Appends the end of a Grid tag output header cell with the supplied data string.

Example

<hya:HeadPost value=”</strong>”/>

Attributes

string: data

<hya:HeadPre/>

Precedes a Grid tag output header cell with the supplied data string.

Attributes

string: data

Example

<hya:HeadPre value=”<strong>”/>

<hya:HeadTD/>

Appends the <TD> HTML tag of a Grid tag output header cell with the supplied 
attribute string. Used to modify <TD> tag attributes for color, alignment, and other 
attributes. String data must specify valid HTML attributes for the <TD> tag, or the 
Web browser cannot render the cells.

Attributes

string:data
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Example

<hya:HeadTD value=”align=’right’“/>

<hya:Home/>

Returns the URL of the Hyperion Analyzer Home page.

<hya:InfoAcross/>

Returns the Information panel Across axis segment.

<hya:InfoDatabase/>

Returns the Information panel Databases segment.

<hya:InfoDown/>

Returns the Information panel Down axis segment.

<hya:InfoFilters/>

Returns the Information panel Filters axis segment.

<hya:InfoPages/>

Returns the Information panel Pages axis segment.

<hya:InfoPanel/>

Returns the Hyperion Analyzer HTML Web Client Information panel.

<hya:InfoRestrict/>

Returns the Information panel Restrict Data segment.

<hya:InfoSort/>

Returns the Information panel Sort segment.
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<hya:InfoTopBottom/>

Returns the Information panel Retrieve Only Top/Bottom segment.

<hya:InfoTrafficLight/>

Returns the Information panel Traffic Lighting segment.

<hya:InfoUser/>

Returns the Information panel User segment.

<hya:LinkTo/>

Launches the current report in the specified value of the Type attribute.

Attributes

type

Values

JavaClient

HTMLClient

<hya:Logout/>

Returns the URL to log out the user.

<hya:Message/>

Returns any status messages generated by the program. The tag only returns errors 
generated by tags placed sequentially before it in the template.

<hya:NewReport/>

Returns a URL to initiate creating a new report.

<hya:NextPage/>

Returns a URL to go to the next page in the page series of the current data object.
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<hya:NextReport/>

Returns a URL to go to the next report in the current report group.

<hya:PageCount/>

Returns the number of pages in the current data object of the current report.

<hya:PageNumber/>

Returns the page number of the current page in the current data object of the 
current report.

<hya:Pages/>

Returns a list of all the pages in the current data object of the current report.

Sample

<SELECT>

<OPTION>East</OPTION>

<OPTION>West</OPTION>

</SELECT>

<hya:Password/>

Returns the user password.

<hya:PostLogin/>

Returns post login actions. For more information, examine the login.jsp file for the 
contents of the string stored there.

<hya:PreviousPage/>

Returns an HTML version of the previous page in the page series of the current 
data object.
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<hya:PreviousReport/>

Returns an HTML version of the previous report in the current report group.

<hya:RefreshEdits/>

Returns the URL to reload the data for the current grid. Often used with Edit Data 
mode HTML controls that reload the current grid with the last saved values.

<hya:RelatedContent/>

Returns the related contents of the selected data cell. 

<hya:Reload/>

Returns the URL to reload the current report. Often used for HTML controls that 
reload the current report per the last save.

<hya:Report/>

Returns an HTML version of the current report.

<hya:ReportDescription/>

Returns the report description.

Sample

Profit Report for the Eastern Region

<hya:ReportGroupList/>

Returns a combo box list of the names of the report groups that a user has access.

<hya:ReportGroup/>

Returns the name of the current report group.

Related Content Column Description

Related Content Icon Each content type can have an icon

Related Content String An HTML anchor link to the content on the server.
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<hya:ReportHeight/>

Returns the height of the current report in pixels.

<hya:ReportManager/>

Returns the Hyperion Analyzer HTML Web Client Report Manager as an 
expandable and collapsible node tree.

<hya:ReportName/>

Returns the name of the current report.

<hya:ReportSize/>

Changes the current report height and width.

Attributes

Example

<hya:ReportSize height=”480” width=”640”/>

<hya:ReportState/>

Returns the state of the current report in a string so that the Java Client displays the 
report in the same state as the HTML Client.

<hya:ReportWidth/>

Returns the width of the current report in pixels.

<hya:Res/>

Gets a string value from a (language based) resource property file.

Attribute Description

height The height of the report in pixels, with 
the value equal to an integer in a string.

width The width of the report in pixels.
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Attribute

id: maps the propertyname to a propertyvalue in a property file

<hya:Save/>

Returns a URL to execute to save the current report.

<hya:Script/>

Returns the Java Script necessary to handle interactive requests such as user 
actions and page navigation.

<hya:ServletURL/>

Returns the URL of the Hyperion Analyzer HTML Web Client servlet engine.

<hya:SetParam/>

Returns a URL to indicate an action for setting parameters.

<hya:ShowAbout/>

Returns the URL to show the About dialog box.

<hya:ShowReportManager/>

Returns the URL to show the Report Manager.

<hya:ShowSaveAs/>

Returns a URL to show the Save As dialog.

<hya:Startup/>

Returns the URL to do what the Startup User Preferences is set to do. For example 
load a report, load a specific report group, etc.

<hya:ToggleFilters/>

Returns a URL to toggle Filters on or off.
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<hya:ToggleInfo/>

Returns the URL to toggle the Web Client Information panel.

<hya:ToggleMultiPage/>

Returns the URL that toggles the Hyperion Analyzer HTML Web Client Page 
Control panel between multiple and aggregated page combo boxes.

<hya:ToggleStyle/>

Returns the URL that toggles between different Hyperion Analyzer HTML Web 
Client grid style.

<hya:UserCredential/>

Returns a string containing user information that is used to authenticate a user.

<hya:UserID/>

Returns the name of the user.

<hya:Version/>

Returns the <major>.<minor>version number of Hyperion Analyzer. 

<hya:WebAppURL/>

Returns the URL of the Hyperion Analyzer Web application.

Example

http://<servername>/Analyzer6_Server/

Template Tag Styles
Custom HTML styles have been defined to speed development. Styles have been 
separated into three groups:

● Template Styles
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● List Template Styles

● About Styles

Use these styles in Cascading Style Sheets or declare them in line as needed.

Example
.gridOddRow{background-color:#A6C9C9;}

Template Tag Styles List
The following tables list and describe the each of the following template tag styles:

● Template Styles

● List Template Styles

● About Styles

Use these styles in Cascading Style Sheets or declare them in line as needed.

Example
.gridOddRow{background-color:#A6C9C9;}

Table 6: HTML Client Template Style Tags

Style Description

gridEvenRow Formats even numbered rows.

gridOddRow Formats odd numbered rows.

gridData Formats grid data cells.

gridNegData Formats data cells with negative values.

gridColHeader Formats column headers.

gridRowHeader Formats row headers.

gridRowTitle Formats the upper left hand corner of grid row titles.

infoHeader Formats the Information panel headers.

infoData Formats Information panel data.
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HTML Web Client Actions
Web developers can further customize Hyperion Analyzer HTML behavior by 
including “actions” and their parameters in uniform resource locators (URL) 
pointing to the Hyperion Analyzer HTML Web Client facility. Such an URL would 
consist of the following elements:

Table 7: HTML Client List Template Style Tags

Style Description

groupStyle Formats report group lists.

viewStyle Formats report lists.

highlightStyle Formats selected report groups with highlighting.

Table 8: HTML Client About Style Tags

Style Description

version Formats Hyperion Analyzer version information.

copyright Formats Hyperion Analyzer copyright information.

server Formats server information.

warning Formats warning information.
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Note: HTML actions and their parameters are delimited by the ampersand (&) 
character. The ampersand character is typically omitted directly following the question 
mark (?) delimiter to avoid confusion and redundancy.

Using Actions
HTML actions are commands to the HTML Web Client included in the URL.

Example

To Log on to Hyperion Analyzer:

http://[ServerName]/[PathName]? Action=login&userid=
[UserID]&password=[Password] 

Because URLs do not accommodate empty spaces, users are reminded to use 
“%20” to represent the spaces in strings.

Actions List

Action
Indicates the action to perform. See the Actions List above for a complete list of 
actions.

Table 9: Hyperion Analyzer HTML Web Client URL Components

URL Element Description

http:// Protocol

ServerName The name of the server hosting the Hyperion 
Analyzer HTML Web Client.

PathName The Path to Hyperion Analyzer HTML Web Client 
servlet engine.

? The required question mark (?) delimiter.

SID Secondary ID. The established session handle.
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About
Returns Hyperion Analyzer HTML Web Client About dialog box information.

Analyze
Loads the Analyze template (the Java Client launch page.)

CancelDBLogin
Cancels the database login.

CancelEdit
Cancels the Edit Data mode.

Note: This action requires that the user understand the process of initiating and ending 
Edit Data mode. Edits can only be applied to the current page of the current data object.

CancelSave
Cancels the SaveAs action and returns to the current report template.

ChangePassword
Changes the Hyperion Analyzer password for the current user ID.

Parameters

password - the current password

newpassword - A new password

DBLogin
Logs on to the specified database.
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Parameters

Desktop
Displays the Desktop template.

DimBrowser
Displays the Dimension Browser template, if there are available values for the 
events parameters they are displayed in the Dimension Browser.

Parameters

DrillCell
Displays the Related Content template of the specified view for the specified row 
and column.

Parameter Description

dbname The database id.

dbuserid A valid user ID for the specified database.

dbpassword The password for the user ID.

saveuid Indicates to save the login information for future use. 
Values of “1” or “True” indicate to save.

Parameter Description

view Indicates the specific data object on the report that is 
displayed in the DimBrowser. 

dimension Indicates the dimension that is displayed in the 
DimBrowser.

event Indicates any event sent to the DimBrowser template in 
a URL that updates the template. For a list of events see 
the <hya:DimBrowserEvent/> tag.
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Parameters

DrillDown
Drills down on the specified dimension member of the specified data object.

Parameters

DrillUp
Drills up on the specified dimension member of the specified data object.

Parameter Description

view Indicates the specific data object on the report where the 
Related Content identifier is located.

row The integer representing a specified table row.

col The integer representing a specified table column.

Parameter Description

view Indicates the specific data object in the report where 
drilling takes place. Data object names are listed in the 
Tree View panel when the Hyperion Analyzer Java Web 
Client is in Design Report mode.

dimension Indicates the dimension on which to drill.

member Indicates the dimension member on which to drill.
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Parameters

DrillToTop
Drills to the top member of the specified dimension member of the specified data 
object.

Parameters

EditData
Initiates the Edit Data mode, enable users to change data and send new values back 
to the database.

Note: This action requires that the user understand the process of initiating and ending 
Edit Data mode. Edits can only be applied to the current page of the current data object.

ExportToHtml
Exports the current report to HTML using the specified parameters. This action is 
used to support batch export.

Parameter Description

view Indicates the specific data object on the report where 
drilling takes place. Data object names are listed in the 
Tree View panel when the Hyperion Analyzer Java Web 
Client is in Design Report mode.

dimension Indicates the dimension on which to drill.

member Indicates the dimension member on which to drill.

Parameter Description

view Indicates the specific data object in the report where 
drilling takes place. Data object names are listed in the 
Tree View panel when the Hyperion Analyzer Java Web 
Client is in Design Report mode.

dimension Indicates the dimension on which to drill.

member Indicates the dimension member on which to drill.
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Parameters

FocusDisplayObject
Sets the current data object of the current report.

Parameters

view - Indicates the specific data object on the report to receive focus. Data object 
names are listed in the Tree View panel when the Hyperion Analyzer 
Java Web Client is in Design Report mode.

Home
Displays the Hyperion Analyzer Desktop.

LoadGroup
Loads the specified report group.

Parameters

group - The ID of the report group.

LoadReport
Loads the specified report.

Parameters

report - The name of the report.

group - The name of the report group containing the report.

Parameter Description

groupname The name of the report group that the report is stored.

reportname The name of the report to export.
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Login
Logs in to the Hyperion Analyzer Analysis Server, starts the Hyperion Analyzer 
HTML Web Client and displays the defined Startup page.

Parameters

Logout
Terminates the session specified by the SID number.

MoveDim
Relocates the dimension on the specified axis and position to another axis and 
position.

Parameters

NewDispType
Changes the current data object to the specified display type. Data objects with a 
chart display type also require a dispsubtype, or chart type, to be defined.

Parameter Description

userid A valid Hyperion Analyzer user ID

password The password for the user ID.

Parameter Description

axisto Indicates the destination axis to which the dimension is 
moved.
1 - column axis
2 - row axis
3 - page axis
4 - filter axis

posto Indicates the position on the specified axis the 
dimension takes. Uses a zero-based index. Zero (0) is 
the first position.

dimension Indicates the dimension to move, and thereby its current 
axis and position.
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Parameters

disptype - The display type of the current data object.

dispsubtype - The chart type of a chart.

NewPage
Displays a specified page using its page number in the page series.

disptype Display Type Value

0 Default

1 Spreadsheet

2 Chart

3 Pinboard

dispsubtype Chart Type Value

1 Chart Type Values

2 Vertical Bar Chart

3 Line Chart

4 Pie Chart

5 Quadrant Chart

6 Area Chart

7 Multi-type Chart (Unsupported)

8 Marks Chart

12 Spline Chart (Unsupported)

13 Curved Area Chart (Unsupported)

14 Pareto Chart

17 Bubble Chart

20 Horizontal Bar Chart

21 User's Default Chart Type (User Preferences)

22 Last Selected Chart Type (Unsupported)

23 Box Plot Chart (Box and Whiskers) (Unsupported)
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Parameters

pageno - The page number of the specified page. Uses a zero-based index.

NewReport
When the action is used without parameters, it displays the New Report template. 
When the following parameters are provided the new report is created.

Parameters

NextReport
Returns the next report in the report group.

PrevReport
Returns the previous report in the report group.

RefreshEdits
Reset the Edit Data mode cells to their last saved values.

Reload
Reloads the current report in the report template.

ReportManager
Returns the HTML Web Client Report Manager node tree. The tree contains nodes 
representing reports and report groups.

Parameter Description

dbid the index of an existing database connection.

layout consists of the following layout types:
1 - spreadsheet
2 - chart
3 - vertical combo
4 - horizontal combo
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RunCalc
Reconsolidates the Hyperion Essbase database after changes have been posted.

calcname - The name of the Hyperion Essbase server calc used to re-consolidate 
the database.

Save
Saves the current report

SaveAs
Saves the current report with another report name. The current report parameters 
that are not changed, are retained for the new report.

Parameters

SaveAsPage
Displays the Save As template.

SendData
Posts Edit Data mode changes to the Hyperion Essbase database.

Note: This action requires that the user understand the process of initiating and ending 
Edit Data mode. Edits can only be applied to the current page of the current data object.

Posting is achieved on a cell by cell basis, with all cell values being sent. Each 
posting must be in the following format:

rrrrcccc=n

Where n is the value located at row rrrr and column cccc.

Parameter Description

newgroup A name of a report group.

newname A new name of the report.

newdesc A description of the report.
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Example

To send a spreadsheet with two rows, one column, and the values 5 and 10, the 
action would be entered:

&action=senddata&00010001=5&00020001=10

SetDim
Selects the specified dimension member and related dimension members defined 
by an Advanced Member Selection mode.

Parameters

SetParam
Updates the server with parameter values to set current and subsequent report 
widths and height. The value of the parameters are stored in memory for the 
duration of the user session.

Parameter Description

view Indicates the specific data object on the report. Data object 
names are listed in the Tree View panel when the Hyperion 
Analyzer Java Web Client is in Design Report mode.

dimension Indicates the dimension.

member Indicates the dimension member.

mode The Advanced Member Selection mode:
0 - Select Member
1 - Also Select Children
2 - Also Select Descendants
3 - Also Select Parent
4 - Also Select Ancestors
5 - Also Select Siblings
6 - Also Select Dim Bottom
7 - Also Select Dim Top
8 - Also Select Level
9 - Also Select Generation
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Parameters

SetServiceDispatcher
Executes the action of the services control specified by the following parameters. 
Currently requires an internal services dispatcher ID number.

Note: Does not support the following services: Log off, User Preferences, Report 
Manager, Launch Executable, Print Screen, or Print Current Report.

Parameters

sdname - The services dispatcher ID number

SetSubscriptionController
Executes the selection action of the subscription control specified by the following 
parameters. Currently requires an internal subscription controller ID number.

Parameter Description

reportwidth The new width of the report.

reportheight the new height of the report.
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Parameters

Startup
Executes the action defined by the Startup User Preferences is set to do. For 
example load a report, load a specific report group, etc.

ToggleFilters
Shows or hides Filters in the interface.

ToggleInfo
Shows and hides the Information panel.

ToggleMultiPage
Toggles the Page Control panel between multiple and aggregated page combo 
boxes.

ToggleStyle
Toggles between the grid styles.

Parameter Description

sctype An integer indicating the type of subscription control:

• radio

• combo box

• button

• checkbox.

scname An internal subscription controller id number.

scitem The control text. The scitem parameter is different for each of the 
four supported subscription controller types:

• check boxes and radio buttons - the control text.

• combo box - the zero-based index of the menu series.

• button - the text label.

scselected (Checkbox Only) True indicates the checkbox is selected.
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Samples
The following topics provide sample templates, tags and actions that you can 
model in the creation of your own HTML content.

Using Actions to Retrieve Information
Hyperion Analyzer provides a technique for gathering information from returned 
html headers.

Portal
By adding the portal=1 parameter to the end of the Login or LoadReport actions, 
users can retrieve additional information in the HTTP response header.

Using portal at the end of a Login action returns the Login Status and user SID 
(“X-Login-Status”, “X-Login-SID”, X-SSO-Login-status) in the response header. 
The Login Status indicates the success of the login effort:

1 - Success

-1 - Error

-2 - Change Password

-3 - Logon failed with token

The X-SSO-Login-Error returns an error code if external authentication is 
configured and then a login fails.

The user SID, or session ID, is the session handle number.

Using Portal at the end of the LoadReport action returns the names of all the data 
sources (“X-Datasource-Names”) and data source types (“X-Datasource-Types”) 
for all the data objects on the report.

➤ To log on to Hyperion Analyzer:

http://[ServerName]/[PathName]?Action=login&userid=
[UserID]&password=[Password]

➤ To retrieve the Login Status and SID:

http://[ServerName]/[PathName]?Action=login&userid=
[UserID]&password=[Password]&portal=1
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➤ To log on to a specific Hyperion Analyzer session:

http://[ServerName]/[PathName]?SID=[Session Handle]&Action=
login&userid=[UserID]&password=[Password]

➤ To log on to a specific report of a specific Hyperion Analyzer session:

http://[ServerName]/[PathName]?SID=[Session Handle]&Action=
loadreport&group=[Group Name]&name=[Report Title]

➤ To retrieve the data source names of specific report of a specific Hyperion 
Analyzer session:

http://[ServerName]/[PathName]?SID=[Session Handle]&Action=
loadreport&group=[Group Name]&name=[Report Title]
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IBM WebSphere
Hyperion Analyzer has been architected to run inside leading J2EE-compliant 
application servers. The supported J2EE Application Server shares Hyperion 
Analyzer business logic, manages network traffic, and maintains system security 
for large numbers of concurrent users.

Differences Between Operating Systems
In Microsoft Windows operating systems, WebSphere is run as a service. The 
current Windows installation uses IBM WebSphere Standard and Advanced 
Editions version 3.5.5. The current IBM AIX UNIX installation uses IBM 
WebSphere Standard and Advanced Editions version 3.5.3.

Administrating WebSphere
Users can monitor and optimize the WebSphere system using the WebSphere 
Administrator's Console.

WebSphere Administrator's Console
The Administrator's Console is a Java applet used to control the WebSphere 
application server. Users can create data sources, numerous applets, servlets and 
Web entities, as well as configure security settings and protocols. WebSphere 
configuration information is stored in the WebSphere Admin Server.

➤ To start the WebSphere Administrator's Console select Start > Programs > IBM 
WebSphere > Application Server V3.5 > Administrator's Console.

The Administrator's Console features its own online documentation.
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WebSphere Admin Server
The WebSphere Admin Server is a repository storing configuration information. It 
does not store any Hyperion Analyzer data.

➤ To start the WebSphere Admin Server, Select Start > Programs > IBM 
WebSphere > Application Server V3.5 > Start Admin Server.
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administrator. An individual who installs and maintains the Hyperion Analyzer 
system, including establishing user IDs, passwords, database connections and 
security. See also System Manager.

Analysis Server. Hyperion Analyzer Analysis Server. An application server that 
distributes report information and enables Web clients to communicate with the 
OLAP server.

asymmetric analysis. A report characterized by groups of members that differ by 
at least one member across groups. There can be a difference either in the number 
of members or in the names of the members.

attribute. A dimension member classification. An attribute can be specified to 
select and group members that have the specified attribute associated with them, 
and to perform calculations and application-specific functions.

attribute dimension. A type of dimension that enables analysis based on the 
attributes or qualities of the members of its base dimension.

axis. A discrete aspect of the two-dimensional report on which multidimensional 
data is displayed, such as filters, pages, rows, and columns.

calculation. The process of aggregating data, or of running a calculation script on 
a database.

calculation script. A set of instructions telling Hyperion Essbase how to 
calculate the values of a database.

cell. A unit of data representing the intersection of dimensions in a 
multidimensional database. Also, the intersection of a row and column in a 
spreadsheet.

chart. One of the three report display types. Chart reports also have a chart type 
property set for them. Charts are created using Hyperion Analyzer.
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child. A member that has a parent above it in the database hierarchy. A child may 
have siblings (peers) that exist at the same level of the database hierarchy.

client. A client interface, such as Hyperion Analyzer, or a workstation on a local 
area network.

column. A vertical display of information in a grid or table. A column can contain 
data from a single field, derived data from a calculation, or textual information. 
Contrast with row.

database. A repository of data within Hyperion Essbase that contains a 
multidimensional data storage array. Each database consists of a storage structure 
definition (outline), data, security definitions, and optional scripts.

database connection. A user-friendly database alias used instead of a long 
database identifier (server name, application name, and database name) that 
enables database references to be more portable.

data source. A named client-side object connecting report components to 
databases, using database connections, queries, and other components.

descendant. Any member below a parent in the database outline.

Desktop. An automatically generated report that dynamically presents buttons 
that enable groups of reports to be accessed with a single click.

dimension. A data category that is used to organize business data for retrieval and 
consolidation of values. Each dimension contains a hierarchy of related members 
grouped within it.

display type. One of three Hyperion Analyzer formats saved to the repository: 
spreadsheet, chart, and Pinboard.

external authentication. The ability to log in to Hyperion applications using user 
information stored outside the application itself; user names and passwords are 
instead managed in a corporate authentication provider such as LDAP or 
Microsoft Windows NTLM.

hierarchy. A set of multidimensional relationships in an outline, often created in 
a tree format.

implied share. A member with only one child, or a member with multiple 
children of which only one child is consolidated. For this reason the parent and 
child share the same value.

intersection. A unit of data representing the intersection of dimensions in a 
multidimensional database. Also, a worksheet cell.
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JDBC. Java Database Connectivity driver. Client-server communication agent 
between Java-based clients and databases.

linked reporting object (LRO). An external file that is linked to a data cell in a 
Hyperion Analyzer report.

member. A discrete item that forms part of a dimension.

missing data. A marker indicating that data in the labeled location either does not 
exist, contains no meaningful value, or was never entered.

multidimensional database (MDDB). A method for referencing data through 
three or more dimensions. An individual record is the intersection of a point for a 
set of dimensions.

multithreading. A client-server process that enables multiple users to work on 
the same applications without interfering with each other.

online analytical processing (OLAP). A multidimensional, multi-user, 
client-server computing environment for users who need to analyze consolidated 
enterprise data in real time. OLAP systems feature drill-down, data pivoting, 
complex calculations, trend analysis, and modeling.

parent. A member that has subordinate members below it in the hierarchy.

personal variable. A means by which users define and name complex member 
selections.

pinboard. One of the three report display types. Pinboards are graphic reports, 
composed of backgrounds and interactive icons called Pins. Pinboards are created 
using Hyperion Analyzer Design Tools.

point of view (POV). A means by which users automatically insert dimensions 
and members that are of interest to them into the reports of others.

pins. Interactive icons placed on graphic reports called pinboards. Pins are 
dynamic. They can change images, and traffic lighting color based on the 
underlying data values and analysis tools criteria.

report. A Hyperion Analyzer display of selected multidimensional cube 
dimensions and members. A report is both the content and the format of the 
display. After it is saved to the repository, a report becomes a multipurpose file that 
users can display in numerous formats.

report group. A group of Hyperion Analyzer reports.

repository. A set of relational database tables for storing report definitions and 
Hyperion Analyzer system information.
■ 115Hyperion Analyzer Administrator’s Guide



Glossary
role. A user type label. Roles give or withhold the permissions needed for various 
Hyperion Analyzer tasks.

row. A horizontal display of information in a grid or table. A row can contain data 
from a single field, derived data from a calculation, or textual information. 
Contrast with column.

query. A component of the data source. Queries are SQL statements submitted to 
the database, which return multidimensional intersection result sets.

server. A multi-user database server that accesses data values based on the 
intersection of dimension members.

single sign-on. The ability for a user to access multiple Hyperion Applications 
after logging on just once using external credentials.

spreadsheet. One of the three report display types. Spreadsheets are tabular 
reports of rows, columns and pages, created using Hyperion Analyzer.

subset. A group of members selected by specific criteria.

substitution variable. A variable that acts as a global placeholder for information 
that changes regularly. You set the variable and a corresponding string value; the 
value can be changed at any time.

System Manager. An individual who installs and maintains the Hyperion 
Analyzer system including establishing user IDs, passwords, database 
connections, and security. See also administrator.

toolbar. A series of shortcut buttons providing quick access to the most 
frequently used commands.

traffic lighting. Color-coding of report cells, or Pins based on a comparison of 
two dimension members, or on fixed limits. Traffic lighting definitions are created 
using the Hyperion Analyzer Traffic Light Analysis Tool.

Uniform Resource Locator (URL). An address for a resource in the World 
Wide Web, such as a document, an image, downloadable files, a service, or an 
electronic mailbox. URLs use a variety of naming conventions and access 
methods, such as HTTP, FTP and Internet mail. URLs can point to files on a local 
network drive, or to reports in the Hyperion Analyzer repository.
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